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Lesson 1
Introduction

When you complete this lesson, you will be able to:

� Describe the relationship between Parts, Assemblies and Drawings;

� Identify the principal components of the SolidWorks user interface;

� Download and extract the required companion files. 
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Using This Book

The SAE Design and Analysis Project with SolidWorks Software 
helps you learn the principles of assembly design and structural analysis using 

SolidWorks and SolidWorks Simulation as an integral part of a creative and 

iterative design process.

For this project, You will “learn by doing” as you complete modeling and 

structural analysis lessons. 

What is SolidWorks Software?

SolidWorks is design automation software. In SolidWorks, you sketch ideas and 

experiment with different designs to create 3D models using the easy to learn 

Windows® graphical user interface. 

SolidWorks is used by students, designers, engineers and other professionals to 

produce single and complex parts, assemblies and drawings.

Prerequisites

Before you begin the SAE Design and Analysis Project with 
SolidWorks Software you should complete the following online tutorials that 

are integrated in the SolidWorks software: 

� Lesson 1 - Parts

� Lesson 2 - Assemblies

� Lesson 3 - Drawings

You can access the online tutorials by clicking Help, SolidWorks Tutorials, All 

SolidWorks Tutorials (Set 1). The online tutorial resizes the SolidWorks 

window and runs beside it.

As an alternative, you can complete the following lessons from CAD Instructor 

Guide:

� Lesson 1: Using the Interface

� Lesson 2: Basic Functionality

� Lesson 3: The 40-Minute Running Start

� Lesson 4: Assembly Basics

� Lesson 6: Drawing Basics



SolidWorks Introduction
Engineering Design and Technology Series

Conventions Used in This Book 3

Conventions Used in This Book

This manual uses the following typographical conventions:

Before You Begin

If you have not done so already, copy the companion files for the lessons onto 

your computer before you begin this project.

1 Start SolidWorks.

Using the Start menu, start the SolidWorks application.

2 SolidWorks resources.

Click the SolidWorks Resources tab  and click 

Student Curriculum.

Convention Meaning

Bold Sans Serif SolidWorks commands and options appear in this style. 

For example, Insert, Boss means choose the Boss option 

from the Insert menu.

Typewriter Feature names and file names appear in this style. For 

example, Sketch1.

17 Do this step. The steps in the lessons are numbered in sans serif bold.
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3 SolidWorks Content.

Expand the SolidWorks Educator Curriculum 

folder.

Expand the proper Curriculum <year> folder.

Click Design Library  to open the design 

library task pane.

Click the SAE Car Design Project folder.

The lower pane will display an icon 

representing a Zip file that contains the 

companion files for this project.

4 Download the Zip file.

Press Ctrl and click the icon.

You will be prompted for a folder in 

which to save the Zip file.

Ask your teacher where you should 

save the Zip file. Usually the 

C:\Temp folder is a good location.

Click OK. 

Tip: Remember where you saved it.
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5 Open the Zip file.

Browse to the folder where you saved the Zip file in step 4.

Double-click the SAE Project Files.zip file.

6 Click Extract.

Click Extract and Browse to the location where you want to save the 

files. The system will automatically create a folder named 

_SAE_Project_ENG in the location you specify. For example, you might want 

to save it in My Documents. Check with your teacher about where to save the 
files.

You now have a folder named SAE Project Files on your disk. The data in this 
folder will be used in the exercises.

Tip: Remember where you saved it.

Analyzing a Structure Using SolidWorks and SolidWorks Simulation

During this session, you will learn how to analyze a structure using SolidWorks 

and SolidWorks Simulation. 

Once you have had a chance to see how easy it is to use SolidWorks solid 

modeling software, you will use an assembly to check whether components fit 

properly. 

You will then make a drawing of one of the components, complete with a cut list. 

If a printer is available, you can print out a hardcopy of your drawing.
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Lesson 2
Using Assemblies

When you complete this lesson, you will be able to:

� Understand the difference between edit assembly and edit part modes;

� Create a virtual, in-context part;

� Open a part from the assembly; 

� Create a new instance from an existing instance;

� Set the materials in a part; 

� Use pack and go to manage the files. 
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Creating Parts In-Context 

A thorough knowledge of how to work with 

assemblies is critical to success with SolidWorks. 

In this example, you will create a virtual part and 

use in-context techniques to mode a brake pad using 

geometry from both the Rotor - Cast Iron and 
Brake Caliper components. 

The component will copied to create a second 

instance and it will be mated into the assembly.

Opening an Assembly with Quick View

Clicking the Quick view / Selective open when you open an assembly allows 

you to view only the components that you want to view.

1 Open Brake&Wheel. 

Click File, Open and select the assembly Brake&Wheel from the Lesson 
2\Brake&Wheel folder. Select Mode: Large Design Review and click 
Open. Click OK on the Large Design Review page.

Note: At the message: Graphics data might be out of date for the flagged 
components because these components reference inactive 
configurations, click OK.
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Hiding and Showing Components

Components can be hidden or shown at any time to create an uncluttered display 

and make working on the assembly faster. 

In addition, components that are hidden before opening the assembly are not 

loaded into memory, further decreasing the load on the machine. 

Tip: The Quick view / Selective open settings are stored in a Display State. 

There are many ways to hide and show components. Here are a few useful 

methods and where they are best used. 

2 Orientation. 

The assembly opens in an Isometric orientation. Click in the graphics area and 
press Shift+Arrow Up to change the view orientation.

Hiding Components Showing Components

Many 

Components

Hide Others- Hides all 

visible components but the 

selected component(s). 

Show Hidden Components- 

Shows all the hidden 

components for selection. 

Single or 

Few 

Components

Hide/Show Components- 

Hides the selected visible 

components. 

Hide/Show Components- 

Shows the selected hidden 

components. 
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Where to Find It

� Shortcut Menu: Right-click a component and click Hide Others

3 Hide others. 

Right-click the Rotor - Cast Iron and select Hide Others. 

Where to Find It

� Shortcut Menu: Right-click and click Show Hidden Components

4 Show hidden. 

Right-click in the graphics area and select Show Hidden 

Components. Click the Brake Caliper component as shown. 

Click Exit Show-Hidden to complete the command.
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Where to Find It

� CommandManager: Large Design Review > Selective Open  > 

Selective Open 

5 Selective open. 

Click Selective Open .

Click All components displayed and 

click Open. These are the only 

components that we need to view right 

now. 

6 Message. 

A message appears. 

Because you used “Selective Open”, hidden components are not 
loaded into memory. Therefore, when you first show a hidden 
component you might notice a delay while it is loaded. Also, a 
new Display State is created corresponding to the “Selective 
Open” state. Click OK. 

7 Display state. 

The changes are stored in the original display state 

Default_Display_State-1.

8 Save.

Click File, Save  to save the assembly and parts.
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9 Orientation changes. 

Press the Spacebar and double-click the orientation *Isometric 
from the dialog. Middle (wheel)+click and drag the edge of the 

Rotor - Cast Iron as shown to rotate the geometry. 

10 Zoom. 

Click the Brake Caliper 
component in the FeatureManager 

design tree and click Zoom to 

Selection . 
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The Assembly FeatureManager design tree

The assembly is comprised of components and mates. The components can be 

either part components or assembly components (sub-assemblies). The assembly 

FeatureManager design tree shows an accurate snapshot of the assembly using 

icons and text to describe the current settings. 

Component

Hidden Sub-assembly
Component

Instance

Mate

Part Component

Hidden

Mates
Folder

Part
Component

Sub-assembly
Component
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Where to Find It

� CommandManager: Evaluate > AssemblyXpert 

� Menu: Tools, AssemblyXpert

11 AssemblyXpert. 

Click AssemblyXpert . The dialog lists the number of parts, unique parts, sub-

assemblies and unique sub-assemblies among other things. 

Click OK.
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Working In-Context

Working in-context means editing a component (part or assembly) while in the 

context of the assembly. The mode is toggled between Edit Assembly and Edit 
Part. 

Edit Assembly Mode vs. Edit Part Mode

When an assembly is opened, it opens in the default Edit Assembly mode. To 

create or edit a component part in-context, Edit Part is used. You can toggle back 

and forth between the modes using Edit Component . 

Tip: Colors are used to indicate which mode is currently active. See “Why do the 

Colors Change?” on page 17 for more information. 

Below is a breakdown of some common actions that are typically performed in 

each mode: 

Edit Assembly Mode Edit Part Mode

Adding new components Creating new sketches

Inserting mates Creating sketch geometry

Moving components Creating bosses or cut features

Edit Assembly Edit Part
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In-Context Parts and Virtual Parts 

In-Context Parts are parts that are created or edited 

in the context of the assembly. In-context part names 

appear in the FeatureManager design tree appended 

with an arrow (In-Context->). 

Virtual Parts are in-context parts that are saved 

within the assembly rather than as separate part files. 

Parts can be both in-context and virtual. Virtual part 

names appear in the FeatureManager design tree in 

square brackets [Virtual_Part^Test]. 

Why use In-Context and Virtual Parts?

In-Context parts reference other parts in the assembly and change automatically 

when the references change. 

Virtual Parts are more flexible because they can be renamed, deleted or saved as 

external (part) files at any time. 

Tip: If there are no references, do not create the part in-context. 

Setup for Using Edit Part 

There are settings under system options that can be used to determine how 

assemblies and virtual parts behave in Edit Part mode.

Where to Find It

� CommandManager: Assembly > Edit Component 

� Shortcut Menu: Right-click a component and click Edit Part 

12 Virtual part setting. 

Click Tools, Options, System Options, Assemblies and clear Save new 

components to external files. 

Do not click OK yet. 

13 In-context appearance setting. 

Click Display/Selection and select Opaque Assembly from the pulldown menu 

under Assembly transparency for in context edit. 

Do not click OK yet. 

14 In-context part setting. 

Click Colors and click Use specified color when editing parts in assemblies. 

That color is listed under the Assembly, Edit Part setting. 

Click OK. 
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Creating a New Part 

Creating a in-context new part 

requires a few selections including a 

planar face or plane for use as a 

sketch plane. 

The selected face or plane will 

establish the orientation and position 

of the Front plane of the new virtual 
part. This in turn defines the 

orientations of the Top and Right 
planes. 

Where to Find It

� CommandManager: Assembly > Insert Components , New Part 

� Menu: Insert, Component, New Part

15 New part. 

Click New Part  and select the face of the Brake Caliper as shown. 
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Edit Part Mode 

Edit Part Mode is the opposite toggle of Edit Assembly Mode and allows the use 

of sketch and feature tools within the assembly. It is triggered by adding a new 

part component or editing an existing part in the assembly. 

Why do the Colors Change?

Due to the settings made (“Setup for Using Edit Part” on page 15), the appearance 

of all the parts remains opaque. The part being edited will appear in the 

Assembly, Edit Part color and all others appear in the Assembly, Non-Edit 

Parts color. 

Controlling the Display

The display includes the visibility and colors of the components in the assembly. 

Controlling the display is the first step in managing the assembly itself, and the 

Display Pane is one of the best tools. 

Display Pane

The Display Pane is a portion of the FeatureManager design tree 

that has visual controls and is usually hidden. The columns show the 

current state of Hide/Show, Display Mode, Appearance and 

Transparency and allow you to change them. The options are 

described below. 

� Hide/Show - Toggles between Hide Component and Show 

Component. 

� Display Mode - Sets the display to Wireframe, Hidden Lines 

Visible, Hidden Lines Removed, Shaded With Edges, 

Shaded, or Default Display. 

� Appearance - Sets the appearance of the component. The lower triangle 

represents the part appearance while the upper triangle represents the 

component (assembly level) appearance. 

� Transparency - Toggles Transparency on and off. 

Note: The display pane works independently of the mode. 

Where to Find It

� Display Pane: Hide/Show  in the component row

Note: Click Hide Display Pane  to close the display pane.

H
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16 Display pane. 

Click Show Display Pane  to expand the 

display plane and change the appearance of 

components. 

Expand the Brake Rotor Assembly folder. 
Click the Rotor - Cast Iron component in the 

Hide/Show column as shown to hide it. 

Where to Find It

� CommandManager: Sketch > Convert Entities 

� Menu: Tools, Sketch Tools, Convert Entities

17 Convert entities. 

Select the face and click Convert Entities . 
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Tip: If you see small green icons on the geometry of the sketch, you are seeing sketch 

relations. Click View, Sketch Relations to shut off their display. 

18 Delete. 

Delete three entities to open the end 

of the sketch. 

Note: There is one large arc and two small ones connected to it. Only one small arc is 

shown here. 

19 Convert edge. 

Click Show Display Pane  and show the Rotor - Cast Iron component. 

Select the edge of the Rotor - Cast Iron component and click Convert 

Entities . 
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Where to Find It

� CommandManager: Sketch > Sketch Fillet 

� Menu: Tools, Sketch Tools, Fillet

20 Sketch fillets. 

Click Fillet , set the Fillet Radius to 2.5mm, and select 

the first set of geometry by selecting the geometry inside of 

where they would intersect. 

Repeat the selections for the similar geometry on the opposite side. Click  

twice. 

21 View normal to. 

Click View Normal To  and 

zoom in as shown. 
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22 Delete. 

Box select from upper left to lower 

right as shown to select the three 

entities. 

Delete the three selected entities. 

23 Drag endpoints. 

Drag the endpoint of the vertical line 

outside the geometry as shown. 

Repeat for the other vertical line and 

stop where the endpoints are 

horizontal. 

24 Tangent Arc. 

Click Tools, Sketch Entities, 

Tangent Arc  and create the arc 

between the two endpoints as 

shown. 
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25 Drag and drop. 

Drag the centerpoint of the arc to the 

edge of the circular edge. Drop it on 

the centerpoint that appears. 

26 Previous view. 

Click Previous View  to go back to previous views and zoom states. Return to 

the zoomed isometric view. 

27 Extrude. 

Click Extrude  and set the Depth to 3mm. Click . 
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Understanding the Color Coding 

The part turns blue when the extrusion is completed. The reason was explained 

earlier (“Why do the Colors Change?” on page 17) but until there is a solid body, 

it is difficult to notice. This is the Assembly, Edit Part color and it appears in 

both the graphics and in the FeatureManager design tree. 

28 New sketch. 

Select the face and click Sketch . 
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29 Convert entities. 

Select the edge and click Convert 

Entities .

Where to Find It

� CommandManager: Sketch > Offset Entities 

� Menu: Tools, Sketch Tools, Offset Entities

30 Offset entities. 

Hide the Rotor - Cast Iron component. Click Offset 

Entities  and set the Offset Distance to 2mm. Select the 

edge, click Reverse and click . 

Repeat the procedure for the opposite side. 
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31 Convert. 

Show the Rotor - Cast Iron 
component. Select the edge as shown 

and click Convert Entities . 

Click . 

32 Drag. 

Drag the open endpoints out beyond 

the converted edge. 
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33 Trim. 

Click Trim Entities , 

Power trim . Click+Drag across 

the sections of geometry using the 

paths shown to trim away excess 

geometry. 

34 Sketch fillets. 

Add sketch fillets Radius 1mm in 

four places as shown. 

Tip: If corners are trimmed to a single 

endpoint, select the endpoint to add 

the fillet. 

Extrusions In-Context 

Extrusions can also be created in-context when external 

generator is referenced. In this example, the depth of an 

extrusion is measured as an offset from an existing face. 
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35 Extrude. 

Click Extrude  and set the End Condition to Offset 

from Surface. Set the Offset Distance to 1.5mm. Click in 

Face/Plane field. 

36 Select other. 

Right-click the face as shown and select Select Other. Click the top selection, 

Face@[Brake Rotor Assembly<1>/Rotor - Cast Iron<1>]. 
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Tip: The top selection at the cursor is not listed. Why? It is assumed that if you wanted 

to select that face you would have selected it directly. 

37 Offset distance. 

Check the direction and click .

Edit Assembly Mode

Edit Assembly Mode is the opposite toggle of Edit Part Mode and is the default 

state of the assembly where you can add components and mates. It is triggered by 

exiting the editing of a part in the assembly or opening of an assembly file. 

1 Edit assembly. 

Click Edit Component  or the confirmation corner  to edit the assembly. 

This returns you to edit assembly mode and all the colors return to their original 

settings. 
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Working with Virtual Parts

The virtual part has been stored inside the assembly since it was created. Now that 

it nearly complete, we will save it externally and make it a real part. 

Renaming a Virtual Part

2 Rename.

Right-click the [Part1^Brake&Wheel] component and select Rename Part. 

Type the name Brake Pad. 

Tip: Although the part has been renamed, it remains a virtual part. 

Saving a Virtual Part as an External Part

The virtual part requires a location on disk to store the new *.sldprt file. 

3 Save as external file. 

Right-click the part and select 

Save Part (in External File). The 

file Brake Pad.sldprt is added 
to the assembly folder. 

Click Same As Assembly and 

OK. 

Tip: The part name appears without the square brackets.

Adding Component Instances and Mating

Components can be added to the assembly in several ways. If there is already an 

instance of that component in the assembly, additional instances can be added 

using control+drag and drop. 
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4 Copy an instance. 

Click and Control+drag the Brake Pad<1> component. Drop the component 

outside the Brake Caliper as shown. 

5 Hide component. 

Click the Rotor - Cast Iron component and click Hide Components . 
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6 First mate. 

Press Shift+Up Arrow key. Click Insert, Mate  and select the faces as shown. 

Click Coincident  and Anti-Aligned . Click . 

7 Second mate. 

Press the Down Arrow key. Select the faces as shown, click Coincident  and 

click . 
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8 Third mate. 

Hide the Brake Caliper component. Select the 

faces as shown, click Coincident  and click . 

9 Show.

Show the Brake Caliper component. 

10 Save.

Click File, Save  to save the assembly and parts. 
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Viewing the Mates of a Component 

The mates used to constrain a component can be listed and viewed using View 

Mates. It is a useful tool in understanding how components are used in the 

assembly. 

Note: The arrow symbol  indicates a path to ground. Mates marked like this are the 

ones that hold the component in place. 

Where to Find It

� Shortcut Menu: Right-click a component and click View Mates 

11 View mates. 

Click the Brake Pad<2> and View Mates . 

Note: Click the “x” to close the dialog
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In-Context Part Editing 

Any component part can be edited in the assembly whether it was created in the 

context of the assembly or not. Toggling back to edit part mode uses the same 

command; Edit Part. 

12 Edit part. 

Click Brake Pad<1> and Edit Part . 

13 New sketch. 

Click the face and click Insert Sketch . A new sketch has been created on the 

face. 

14 Convert edge. 

Click the circular edge and click 

Convert Entities . Click . 

Exit the sketch. 
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Opening a Part from an Assembly 

In this example, we will create a slot is to match up with the hole 

in the Brake Pad component. The slot will be constructed 

from an existing hole and makes for easier fit up. 

1 Open Brake Pad. 

Click on the Brake Pad<2> in the FeatureManager design tree and select Open 

. 

2 Edit a sketch. 

Right-click on Sketch3-> in the FeatureManager 

design tree and select Edit Sketch . 

3 Construction. 

Click the circle and click For construction to make it dashed.

Where to Find It

� CommandManager: Sketch > Straight Slot , 

Centerpoint Straight Slot 

� Menu: Tools, Sketch Entities, Centerpoint Straight Slot

4 Slot. 

Click Tools, Sketch Entities, Centerpoint Straight Slot  and place the 

cursor at the center of the circle. Drag the cursor horizontally and click to create 

the centerline. Drag vertically and click to create the height. Click . 
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5 Relations. 

Click the circle and a horizontal line 

of the slot. Add a Tangent  

relation. 

6 Dimension and cut. 

Add a 2mm dimension as shown to fully define the 

sketch. Create a cut using a Through All end 

condition. 

Multi-body Materials

In order to have different materials in the same part there must be multiple solid 

bodies (multi-bodies) within that part. 

This part is currently made up of three features; two bosses and one cut feature. 

They are listed in their order of creation. There is just one solid body because by 

default new boss features are merged to the current body. The part will be edited 

to create multi-bodies. 

Boss-Extrude1-> Boss-Extrude2-> Cut-Extrude1->
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Reordering Features

Features can be reordered in the Feature Manager design tree using drag and drop. 

The rule to remember is that you cannot reorder a child feature before the parent 

feature. So how can you determine the parent/child relationships? 

Parent/Child Relationships 

The Parent/Child tool is used to determine the parents and children of any 

feature. In this case it will be used to determine the limits of where a feature can 

be reordered. 

7 Parent/child. 

Right-click the Cut-Extrude1 feature 
and select Parent/Child. The dialog tells 

you that the Boss-Extrude1 and 
Sketch4 features are the parents of the 
selected feature. This also means that the 

Boss-Extrude2 feature is not. This 
means that the child can be moved to a 

position between the boss features. Click Close. 

Note: The Sketch4 feature is embedded in the Cut-Extrude1 feature. 

8 Reorder. 

Drag the Cut-Extrude1 feature and drop it on the Boss-Extrude1 feature. 
This places it between the boss features. 

9 Folder. 

Right-click the first feature Boss-Extrude1, 
Control+click the second feature Cut-Extrude1 and 
select Add to New Folder. Name the folder Backing. 
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10 Edit feature. 

Click Boss-Extrude2 and Edit Feature . Clear Merge result and click . 

There are now two solid bodies named Cut-Extrude1 and Boss-Extrude2. 
Rename them to Plate and Pad as shown. 

Tip: The default names were taken from the last feature that was applied to the body. 

Materials

Materials can be added to the entire part or to selected solid bodies within the part. 

In this case we will take advantage of the multi-body format to assign different 

materials to each body.

Where to Find It

� Shortcut Menu: Right-click a component or body and click Edit Material 

11 Material for the Plate. 

Right-click the body Plate and select Material, Edit 
Material. Under Steel, select 1023 Carbon Steel Sheet 

(SS). Click Apply and Close. 

12 Material for the pad body. 

Right-click the body Boss-Extrude2 and select 
Material. Under Other Non-metals, select Ceramic 

Porelain. Click Apply and Close. 

Note: Custom materials and custom material libraries can be 

created.
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13 Open assembly. 

Press Control+Tab and move the cursor to the assembly. 

This message appears: 

Models contained within the assembly have changed. Would you 
like to rebuild the assembly now? Click Yes. 

14 Edit assembly. 

Click Edit Component . Hide the Brake Caliper 
and Rotor - Cast Iron components. 

15 Display state. 

Create a new display state and rename to ALL. Right-click in the graphics area 
and click Show Hidden Components. Window-select all the components and 

click Exit Show Hidden.
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Pack and Go

Pack and Go is utility that can be used to copy all files used by the assembly into 

a new folder or zip file, consolidating the file set into one location. 

Work Flow

The work flow using Pack and Go creates multiple backups, using the last backup 

to start the next work session. 

Creating a Zip File

Creating a zip file is a good way to consolidate the files and generate a backup in 

one step. The zip file can be used to start the next session and then be stored away. 

Zip

New
Folder

File
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1 Pack and go. 

Click File, Pack and Go and click Save to Zip file. Using Browse, set the 

location to a temporary folder, name the file Backup_1.zip and click Save. 

2 Unzip.

At the start of the next session, unzip the file to a new folder and begin working. 

More files may be added from external drives or different folders. 

3 Repeat the process.

At the start of the next session, unzip to a new folder and begin working. Repeat 

the process each time to keep all the files together. 

Adding to File Names 

If you want to rename the files with each new backup, the Add prefix and Add 

suffix options can be used. 

For example, the file name Brake Caliper could become Brake Caliper_2 
or 2-Hub Assembly with a suffix or prefix added. 

Note: Using a prefix or suffix changes the name. It is not the same as using the 

SolidWorks Data Management product. 
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4 Appending the names. 

Use the same settings as in the previous step 1 but click Add suffix and type _1 
in the box. Click Save. 

Tip: Virtual parts that have not been saved as external files will appear greyed in the 

list with <internal to assembly> as the folder. They are stored within the 
assembly that was active when they were created. 

5 Save and close all files. 
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Lesson 3
Creating a Weldment

When you complete this lesson, you will be able to:

� Creating weldment parts; 

� Using 3D sketches; 

� Working with sub-assemblies; 

� Creating custom profiles; 

� Adding structural members; 

� Trimming structural members; 

� Editing structural members.
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Creating Weldment Parts 

The Frame will be built as a in-context Weldment using references from 

existing assemblies. The weldment process includes creating sketches, adding 

structural members and trimming the structural members. 

Planes and Sketches 

Planes and sketches, both 2D and 3D, are 

used to define the locations of the 

structural members in the weldment. 

Structural Members 

The structural members, square and 

round tubes in this example, are added to 

the lines and arcs of the sketches. After 

they are added they are trimmed to fit. 
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Weldments 

A Weldment is a multi-body part composed of structural members. The 

centerlines of the structural members are sketched and profiles are selected from a 

library and are applied to the sketches. 

Tip: Most of the work to create a weldment is invested in the creation of the weldment 

sketches. 

Creating a Weldment 

Creating a typical weldment involves several 

steps to create and trim the weldment 

members. 

For example, this weldment is made up of 

five structural members; two of the longer 

length and three of the shorter length. 

The following chart defines the basic steps in 

creating a weldment part. 

Sketch

Create a new sketch that 

defines the centerlines of 

the weldment profiles. 

The sketch can be a 2D or 

3D sketch. 

Close the sketch. 

Create 

Structural 

Members

Click Structural 

Member  and select 

geometry. 

Select a profile from the 

library for use with the 

geometry. [

Trim and 

Extend 

Structural 

Members

Click Trim/Extend  

and trim or extend the 

length of structural 

members to planes or 

other structural members. 
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Some Important Points about Weldments 

Here are some important points to remember about weldments: 

� Weldment parts are multi-body parts. Each structural member is an individual 

solid body. 

� The profiles used are selected from a library. You must create your own 

profiles and library folders if the standard profiles are not what you need. 

� Weldments can make use of symmetry. Structural members can be patterned 

using Mirror with the Bodies to Pattern option. 

� A Cut-List folder is created to store information about the structural 

members and their lengths of the structural members. They can also be sorted 

by equal lengths. 

� A Weldment Cut List table can be generated in a drawing of the weldment. 

� The drawing can also have balloons like a BOM. 

Some Details About Weldment Sketches

Weldment sketches are used to define the centerlines of beams used in the 

weldment. Continuous beams should be created using single pieces of geometry. 

If they are not, smaller separate pieces will be created. 

Sketches used for weldments may be different than sketches used for other 

features. For example, the sketch shown here would not be useful for a boss 

extrude or revolve. 

Single Line Multiple Lines
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1 Open Frame&Suspension. 

Click File, Open and select the assembly Frame&Suspension from the 

Lesson 3\Frame&Suspension folder. 

2 Show sketches. 

Open any instance of the A-Arm Spherical Ball 
component. 

Right-click Sketch1 and select Show. 

Return to the assembly. 

Note: The A-Arm Spherical Ball components can be rotated for a better view of the 

sketch. 
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Using Different Planes and Sketches 

In the process of adding a new part in-context, planar face or plane must be 

selected. This plane is used as a sketch plane and a new sketch is opened. In fact, 

several things happen at once when the plane is selected:

� A new in-context part is created. 

� The new part is being edited. 

� A new sketch is created on the selected plane. 

� The new sketch is open. 

� The selected plane becomes the Front plane of the new part. 

The new sketch may not be sketch you want. Although it is a requirement to select 

something, you do not have to use the sketch. You can just exit the sketch and 

create the plane or sketch that you need. 

3 New part. 

Click Insert, Component, New Part and select the plane Ground. A new 
sketch, in the new part, is automatically started on the selected plane. See 

“Creating a New Part” on page 16 for more information. 

Note: The Ground plane is selected, but in theory any plane or planar face could have 
been selected because none of the existing planes or planar faces is sufficient. 

4 Exit sketch. 

Right-click in the graphics area and select Exit Sketch  to leave the current 

sketch. You are still editing the new part. 
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5 Reference plane. 

Click Insert, Reference Geometry, Plane . 

Select the plane Front plane from the active part 

[Part1^Frame&Suspension]<1> and Parallel. 

Select the centerpoint of an arc from A-Arm Spherical 
Ball (connected to the A-arm - Upper assembly) as 

shown. Click  and rename the plane Upper_Arm.
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6 Lower plane. 

Using the same procedure as the previous step, create a 

new plane using the plane Front and a centerpoint of 
an arc from A-Arm Spherical Ball (connected to 

the A-arm - Upper assembly) as shown. Click  

and rename the plane Lower_Arm. 

Using 2D Sketches

A series of 2D sketches will be created to form the 

basic shape of the frame. 

3D sketches will be used to fill in much of the 

bracing and support structure after the basic shapes 

are complete. 

Note: Many of the 2D sketches, like this one, will require the creation of new planes. 

7 New sketch. 

Right-click the plane Lower_Arm and Sketch . 
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8 Rectangle. 

Click Rectangle  and sketch as shown. 

9 Reference to existing geometry. 

Add dimensions between the centerpoint of the arc and the edge of the rectangle 

as shown. Set the values to 35mm and 30mm. Selection of A-Arm Spherical 
Ball geometry for the dimensions creates external references to that component. 
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10 Centering geometry. 

Sketch a centerline connecting the midpoint of the line and the origin as shown. 

Add a Horizontal  relation.

11 Added line and dimension. 

Add the line and dimensions 710mm and 430mm as shown.
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12 Exit sketch. 

Right-click in the graphics area and select Exit Sketch  to leave the current 

sketch. Rename the sketch Main. 

13 New plane. 

Control+drag the plane Lower_Arm downwards. In the Plane dialog set the 

offset to 115mm. Rename the plane Lower_Frame. 

14 Hide components.

Hide the Steering Wheel and Steering Rack and Shaft Assembly 
assemblies. 

15 New sketch. 

Create a new sketch on the plane Lower_Frame. Sketch the lines and a 
centerline connecting the midpoints of both lines as shown. 
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16 Symmetry. 

Add a Horizontal  relation to the centerline. The two angled 

lines are now symmetric to each other.

17 Relation to inactive sketch. 

Select the centerline of the current sketch, control+select the 

centerline of the inactive sketch and add a Collinear  

relation. 
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18 Complete sketch. 

Add the dimensions as shown. Exit the sketch. Rename the sketch 

Lower_Frame _sketch. 

Renaming and Opening a Virtual Part 

It is easier to work on the part outside the assembly provided that the assembly 

geometry is not being referenced. The part can be opened even though it is a 

virtual part. 

1 Rename the virtual part. 

Right-click the virtual part Part1^Frame&Suspension in the 
FeatureManager design tree and select Rename Part. Type Frame. 

2 Open the virtual part. 

Right-click the virtual part Frame^Frame&Suspension and select Open 

Part . 
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Why is the View Orientation Different? 

When a new part is created in-context, the initial plane or planar face selected 

defines the position and orientation of the Front plane of the new part. This may 

cause the new part to an unexpected orientation, different than that of the 

assembly. Saving a view state is a great solution. 

3 Orientation. 

Click View, Modify, Rotate  and rotate the view orientation so that it looks 

similar to that of the assembly. 

4 Save a view state. 

In order to save the view orientation and zoom, save 

a view state. Press the Spacebar and click the New 

View  icon on the Orientation dialog. 

Type the name ISO and click OK. 

The view name ISO will be added to the list and can recalled by double-clicking. 
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5 Plane. 

Create a new plane using Right and Parallel for the First Reference and the 
endpoint of the Main sketch as the Second Reference. Rename the plane 

Bulkhead1.

6 Sketch geometry. 

Create a new sketch on the plane Bulkhead1. Add lines to the existing 
endpoints of the Main sketch. Select the centerline, control+select the endpoints 

and add a Symmetric  relation. 

Note: Endpoints or geometry can be selected for the addition of a symmetry relation. 

7 Dimensions and fillets. 

Add the three linear dimensions (440mm, 

215mm and 420mm) as shown. 

Click Sketch Fillet  and set the Fillet 

Radius to 100mm. Select four corners as 

shown. Click . 

Tip: If this message appears: At least one 
segment being filleted has a midpoint 
or equal length relation. Geometry 
may have to move to satisfy this 
relation when the fillet is created. Do 
you want to continue? Click Yes. 

Close the sketch and rename it to 

Bulkhead1_Sketch.
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Additional Planes and 2D Sketches

A series of small 2D planes and sketches are needed to define the shape of the 

frame. 

8 Bulkhead2 and Bulkhead3 planes and sketches. 

Create planes parallel to Right through the endpoints in the Main sketch and 
create the following sketches. 

Bulkhead2_sketch

Bulkhead3_sketch Seat_Angle_sketch

Engine1_sketch

Engine2_sketch

Through_Point_Sketch

Bulkhead2_sketch Bulkhead3_sketch
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9 Seat position and angle. 

Create a new plane using Right and Parallel for the First Reference and the 
endpoint of the Main sketch as the Second Reference. Rename to 

Seat_Position. 

Using Seat_Position and the sketch line as shown, create a new plane. Click 
Angle and use 10 degrees. Rename it to Seat_Angle.

Create the sketch and rename it to Seat_Angle_sketch.

Tip: Add the 100mm sketch fillets before the 90mm and 500mm dimensions. 
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Sketching with Pierce Relations 

So far, we have connected geometry to endpoints and midpoints. But what if the 

structural members are connected to an arc or elbow shape? This method utilizes a 

lesser known relation called Pierce. The pierce relation positions an endpoint 

where the sketch plane intersects (pieces) the selected geometry. 

Note: Sometimes it is necessary to create a bracing member in order to create bulkheads 

and other sketches. In this case the position of the bracing member is required to 

sketch the position of a bulkhead. 

10 Edit sketch. 

Edit the sketch Bulkhead1_Sketch. Click Point  

and add a point near the arc. Add a Midpoint relation 

between the point and the arc as shown. Exit the sketch.

11 Plane through point. 

Create a new plane using Front and Parallel for the First Reference and the 
point as the Second Reference. Rename to Through_Point.
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12 Pierce. 

Create a new sketch on the Through_Point plane. Sketch a line from the point 

towards the arc as shown. Select the endpoint and the arc and add a Pierce  

relation. Rename to Through_Point_Sketch.

13 Planes. 

Create a new plane offset 550mm from the Seat_Position plane. Rename to 

Engine1. Offset 300mm from the Engine1 to create Engine2. 
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14 Converting a single sketch entity. 

Create a new sketch on the Engine1 plane. Click Convert Entities  and select 

the centerline in the Seat_Angle_sketch as shown. Click . Click the line and 

select Construction Geometry . Add the lines to the centerline as shown. 

15 Mirror in the sketch. 

Click Tools, Sketch Tools, Mirror  and select the three 

sketched lines. Right-click and select the centerline and 

click . 
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16 Collinear with a plane. 

Add a Collinear  relation between the 

Through_Point plane and the top line and 
add the dimensions as shown. Exit the sketch 

and rename it Engine1_sketch. 

17 Converting an entire sketch. 

Create a new sketch on the Engine2 
plane. 

Click Convert Entities  and select 

the sketch Engine1_sketch using 
the flyout FeatureManager design tree 

as shown. Click . 

Close the sketch and rename it 

Engine2_sketch. 
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Adding Bracing to the Frame

Bracing is added between the existing sketches using more sketches. The best 

practice is to use the type that is most suitable in the situation, 2D or 3D. For more 

information regarding 3D sketches, see “Using 3D Sketches” on page 65. 

Tip: All of the previous sketches could have been created as 3D sketches. 

18 Sketch. 

Create a new sketch on the Through_Point plane. Add the two centerlines, 
three lines and two dimensions as shown. Rename to Engine_Mount. 
Exit the sketch in an under defined state. 

Note: This sketch is another example of a valid weldment sketch that would be 

unsuitable for a standard extrusion. For more information, see “Some Details 

About Weldment Sketches” on page 46. 
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Using 3D Sketches

3D sketches are very useful in creating sketch geometry that does not lie on an 

existing or easily definable plane. Bracing lines that cross through 3D space 

between existing endpoints are best created using 3D sketches.

Where to Find It

� CommandManager: Sketch > Sketch  > 3D Sketch 

� Menu: Insert, 3D Sketch

Sketching in the X, Y and Z Directions 

The Space Handles that appear in a 3D sketch when creating lines can be used to 

sketch along the X, Y and Z directions. The direction is shown at the cursor. 

Note: The space handles can be ignored to sketch between endpoints in 3D space. 

How do you know if you are in a 3D sketch? 

Look at the Status Bar near the bottom right corner of the window. It will say 

Editing 3DSketch1 for a 3D sketch or Editing Sketch6 for a 2D sketch. 

19 3D sketch. 

Click 3D Sketch  and add a line. Start the line at the lower endpoint and end it 

on the angled line as shown. A Coincident relation is added in the process. 
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3D Sketch Dimensions

The Tab key can be pressed while creating a dimension to switch between the true 

distance (absolute) and distances along the X, Y and Z axes. 

Note: Once created, you can use Edit Sketch  to edit either a 2D or 3D sketch. 

Select the line and place the dimension... (Absolute)

Select the line and...

press Tab once 

(Along X)

press Tab twice 

(Along Y)

press Tab three times 

(Along Z)
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20 Dimension. 

Add an absolute dimension of 350mm that defines the true length of the line. 

Exit the sketch. 

21 Assembly.

Press Ctrl+Tab and click the assembly. At the message: Models contained 
within the assembly have changed. Would you like to rebuild the 
assembly now? Click Yes.

22 Edit assembly. 

Edit the assembly by right-clicking in the graphics area and selecting Edit 

Assembly: FrameSuspension. 

23 Save. 

Save the assembly and click Save All. At the message: This assembly 
contains unsaved virtual components which must be saved click 
Save internally (inside the assembly) click OK. 

24 Show display state.

There are many components that have been hidden. They will be shown now. 

Click the ConfigurationManager tab  in the FeatureManager design tree and 

double-click the display state Full_Display State-1. Click the FeatureManager 

design tree tab . 

25 Hide planes. 

If there are planes visible, click View, Planes to turn of the display. 
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Placing a Component Using Sketch Geometry 

The geometry of the frame, an in-context 
virtual part, can be used to create mates as 

well as place and orient components. 

26 Insert component and mate. 

Click Insert, Component, Existing Part/Assembly  and select the ENGINE 
part from the Lesson 3 folder. 

Mate the Right plane of the ENGINE and the Centerline plane of the 
assembly using a Coincident mate. 

Note: Use the Aligned and Anti-Aligned options to get the mate alignment as shown. 
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27 Concentric mate. 

Select the cylindrical face of the engine and the sketch line as shown. Add a 

Concentric mate between them. 

28 Rotate. 

Rotate the under defined component as shown. 
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Making Changes

With the addition of the ENGINE, we can see that it appears to be too close to the 
Engine1_sketch (inside right box). One solution may be to pull the attachment 

point back by shortening the length of a line in the Engine_Mount sketch 
(inside left box). 

29 Change dimension value. 

Return to the part by pressing Ctrl+Tab and clicking the part. 

Double-click the Engine_Mount sketch in the FeatureManager design tree and 

change the dimension to 50mm as shown. Click Rebuild . 
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30 Return to the assembly.

Press Ctrl+Tab and click the assembly. With the change in the sketch geometry, 

the engine has been pulled back to a better position within the frame as shown. 

Working With Sub-Assemblies 

Large assemblies often have multiple sub-assemblies 

within them. This is good practice and helps make the 

assembly easier to work with, shortening the 

FeatureManager design tree and breaking the components 

into logical groups. 

This section will show how to open a sub-assembly from 

the main assembly and set Component Properties. 

Opening a Sub-assembly from the Assembly 

Sub-assembly components can be opened directly from the assembly 

FeaureManager design tree like part components. 

Tip: Right-clicking a component part in the sub-assembly and trying to open it will 

open the part only. 

31 Open sub-assembly. 

Right-click the sub-assembly Rear Axle Assembly from the FeatureManager 

design tree and select Open assembly . 
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Rigid vs. Flexible Sub-Assemblies

All sub-assemblies have the option of being solved as Rigid or Flexible.

Where to Find It

� Shortcut Menu: Right-click a sub-assembly and click Component 

Properties . Change the Solve as option to Rigid or Flexible.

Rigid

Rigid  treats the entire sub-assembly as a single rigid component when used as a 

sub-assembly. Rigid is the default condition for all sub-assemblies. 

Flexible

Flexible  allows the components that can move or rotate in the assembly to 

move or rotate when used as a sub-assembly. 

1 Test component. 

The assembly is designed so that the 

Sprocket is free to move along the 

axis CL Rear Axle. Move it a small 

amount to test it. 

Close the sub-assembly without 

changes and return to the main 

assembly. Click Discard.
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2 Warning. 

To line up the Sprocket with the engine output, select the faces indicated and try 
to add a Coincident mate. A warning saying that the coincident mate cannot be 

added will appear. Click . 

Why Does the Warning Appear?

The sub-assembly is solved as the default rigid condition which does not allow 

components in the sub-assembly to move independently. 

3 Component properties. 

Right-click the Rear Axle 
Assembly and select Component 

Properties . Under Solve as, 

click Flexible and OK. 

Using the same procedure as in 

step 2, add the Coincident mate. 
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Bracing Sketches 

There are several more planes and sketches required to complete the frame 
geometry. 

4 Open part. 

Open the virtual part frame. 

5 Pierce relation sketches. 

Create a new plane through endpoint indicated and Parallel to Front plane. Use 
the plane to create two new sketches. 

In the each sketch, use one Coincident and one Pierce relation. 

Note: The pierce relation in the first sketch uses an arc, the second uses a line. 
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Remaining Sketches 

The remaining sketches are all 3D sketches and will be presented with a brief 

description and an image as shown below. 

Two lines and 

Coincident relations. 

Two lines, 

Coincident and 

Midpoint relations.

One line and 

Coincident relations.
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Why is the Bracing One Sided? 

The resulting structural members will be mirrored across a plane to create the 

bracing on the opposite side. For more information, see “Mirroring Structural 

Members” on page 90. 

Four lines and 

Coincident relations.
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Weldment Structural Members

Weldments use standard profile shapes that are applied 

to sketch geometry to create structural members. Each 

structural member is a separate sold body in the multi-

body part. 

Weldments also track the quantities and lengths of the 

structural members using a weldment cut-list. 

A Quick Look at the Standard Profiles 

The weldment profiles are divided into two Standard folders: ansi inch and 
iso. Profiles must be library features and be present in the folders to be used. The 

standard profiles use these shapes: 

Weldment Cut List

The Weldment Cut List tracks the structural member types and lengths. 

angle iron c channel pipe
rectangular 
or square 
tube

s section or 
sb beam
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Creating Custom Profiles 

We need two profiles: a round (pipe) tube and a square 

tube each with an outside measurement of 25.4mm. 

This size is different than the standard sizes, so they 

will need to be created and placed in the proper 

folders. 

Note: The weldment profiles are set to specific folders by the option Tools, Options, 

File Locations and Weldment Profiles. 

1 Open a new part.

Open a new part with mm units. 

2 Sketch. 

Create a new sketch on the Front plane and sketch a 25.4mm circle and 

dimension as shown. 

Add an offset of 2.4mm as shown and exit the sketch.
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3 Save as library feature. 

Select the sketch Sketch1. Click File, Save As. 

Select the Save as type Lib Feat Part (*.sldlfp), type the file name 25.4mm 
Dia, and click Save. 

For Save in, navigate to the default weldment library folder located in the 

C:\Program Files\SolidWorks Corp\lang\english\
weldment profiles folder. 

Note: If you receive a message that you are not allowed to save in that folder, try saving 

the file in a local folder and moving the file to that folder. Also, the full path used 

in this lesson is based upon the default installation on SolidWorks onto the C 

drive. If SolidWorks has not been installed using the default settings, then the path 

will require some adjustment.

Library Feature Folders and Icons

The library feature is a different file type and uses 

different icons for the top level component and the 

sketch. 

4 Close library feature. 

Close the library feature part. 
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5 Create new Folders. 

Adding the weldment profile to the weldment profiles folder is not enough to 
make use of it. 

Create a new folder FSAE in the 
<Install Directory>\Program Files\SolidWorks Corp
\lang\english\weldment profiles folder. Open that folder and create two 
folders named Square Tubes and Round Tubes. 

Move the 25.4mm Dia.SLDLFP file into the Round Tubes folder. 

6 Move existing file. 

Move the existing 25mm Sides.SLDLFP file into the Square Tubes folder. 

Note: The file can be found in the Lesson 3 folder. 

Why Do Some Profiles Contain Points? 

Profiles formed using lines typically contain points at 

the corners like this tube. They are useful in moving 

the profile to a position other than the centerline. 
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Adding Structural Members

Adding the structural members is the simplest part of the process. Selecting the 

existing sketch geometry gives the structural members position and length. 

It is helpful to keep all the related features together in the FeatureManager design 

tree for future editing. In order to do this, it is best to rollback. See “Using 

Folders” on page 88 for more information. 

1. Move the rollback bar to a position after the sketch feature that you want to 

use for creating structural members. 

2. Select the geometry of inactive sketches to define the centerlines of the 

structural members. 

3. Add only structural members of the same type in the same feature. 

1 Rollback. 

In the Frame part, right-click the Bulkhead2 plane and select 
Rollback . 

This will place the Structural Member feature just after the 
Bulkhead1_Sketch sketch, near the related plane. 

2 Structural member. 

Click Insert, Weldments, Structural Member  and 

the following options: 

Standard FSAE, Type Round Tubes and Size 25.4mm 

Dia. 

Select all the lines and arcs as shown and click .

Rename the structural member feature to Structural Member_Bulkhead1. 
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Corner Treatments 

The Corner Treatments End Miter , End Butt1  or End Butt2  are used 

to determine the trimming of the members meeting at a corner within the same 

feature. 

Corner treatments are applied to all corners in 

the Structural Member dialog and individually 

Individual corner treatments can be set by 

clicking the circular corner markers and setting 

the dialog that appears. 

All
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3 Rollback. 

Drag the rollback bar to a position after the 

Bulkhead2_sketch. 

Note: The Weldment feature is added to the part automatically. This 

defines the part as a weldment part.

4 Structural member. 

Click Insert, Weldments, Structural Member and the 

following options: 

Standard FSAE, Type Square Tubes and Size 25mm 

Sides. 

Make sure Apply corner treatment and End Miter  

are clicked. In this example, all corner treatments will 

remain as end miters.

Select all the lines of the sketch as shown and click .
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Using Groups

The Group option allows you to select multiple “groups” of edges in the same 

dialog. The structural members of each group are automatically trimmed against 

each other; for example the members of Group1 are trimmed by the members of 

Group2. 

Note: The use of groups may limit the selection of corner treatments. 

5 Rollback. 

Drag the rollback bar to a position after the Main-> sketch. 

Group1

Group2
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6 Structural member. 

Click Insert, Weldments, Structural Member and the 

following options: 

Standard FSAE, Type Square Tubes and Size 25mm 

Sides. 

These selections are added to for Group1. 

7 Group. 

Click New Group  and select the three remaining edges for Group2. 

Click . 
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Using Trim/Extend

The Trim/Extend  tool is used to a trim the end of a structural member against 

a face/plane or one or more other structural members. 

It is helpful to keep the related trim/extend features together with the in the 

FeatureManager design tree. In order to do this, it is best to rollback first similar to 

adding structural members. See “Using Folders” on page 88 for more information. 

1. Move the rollback bar to a position after the Structural Member feature 
that you want to trim. 

2. Add one trim/extend feature for each end of the structural member. In the 

simplest cases, the trim/extend feature may include both ends of the structural 

member. 

Trimming Boundary

The trimming boundary can be either a Face/Plane or other Bodies. Options with 

other bodies include Simple cut between bodies and Coped cut between 

bodies. 

Tip: The Trim/Extend tool eliminates interferences between solid bodies by shaping 

the ends and creating the correct fit. Interferences between solid bodies in the 

multibody part can be checked at the assembly level. For more information, see 

“Checking Clearances” on page 98. 

Bodies Bodies Face / Plane
Simple cut between
bodies

Coped cut between
bodies
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8 Trim. 

Drag the rollback bar to a position after the Structural 
Member_Bulkhead1 feature. 

Click Trim/Extend  and click End Trim . 

Select the Bodies to be Trimmed and Trimming 

Boundary Bodies as shown. 

Click Simple cut between bodies  and . 

The Bodies to be Trimmed is shortened using the Trimming Boundary body. 

Bodies to 
be Trimmed

Trimming
Boundary
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Using Folders

Rollback was used in the previous steps to place the trim/extend feature just after 

the structural member being trimmed. This allows us to group a series of related 

features into a Folder, effectively reducing the length of the FeatureManager 

design tree. 

Note: Features can also be dragged and dropped into the folder but they must remain in 

the same sequential order. 

9 Add folder. 

Shift+select the sequence of features as shown. Right-click and select Add to 

New Folder, naming the folder Bulkhead_1 Folder. 

If this procedure is used throughout the FeatureManager 

design tree it will significantly shorten the length of the tree.
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Map for Structural Member Types and Trim/Extend 

The structural member types are either FSAE, Round Tubes, 25.4mm Dia  or 

Square Tubes, 25mm Sides . Create them and add the trimming and folders 

using the map below or the included eDrawings files (below). Use End Trim  

and Trimming Boundary Bodies for all features. 

eDrawings File for Member Types and Trim/Extend 

Double-click the eDrawings 

file frame.eprt  or the 

html file frame.html . 

This will open an eDrawing 

or browser that can be 

zoomed, scrolled and 

rotated using the same tools 

as in SolidWorks. 

Use the eDrawing to 

visually determine the type 

of structural member used 

for each sketch and how it 

is to be trimmed. 
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Mirroring Structural Members 

Mirror can be used to pattern features, faces or bodies across a plane. In this 

example solid bodies will be mirrored to complete the frame. 

10 Mirror bodies. 

Click Insert, Pattern/mirror, Mirror  and click the Top 
plane as the Mirror Face/Plane. Click Bodies to Mirror 

and select the bodies shown in blue. Click . 

Note: Mirroring the bodies after trimming eliminates the need to trim the mirrored 

bodies. 
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Editing 

A big advantage of creating geometry in SolidWorks is the editing capability. You 

can edit sketches and features to change the design at any time. In this section, 

several types of changes will be introduced. 

Editing the Corner Treatment 

The corner treatments used on some of the earlier structural members may seem 

inadequate after all the bracing is added. In this case, an open end makes the 

connection with the brace difficult. 

11 Zoom in. 

Zoom in on the are as shown. This area shows a potential problem where the brace 

member connects to an open face of a square tube. 

12 Edit structural member feature. 

It is not necessary to know the name of the feature. Right-click on a face of any 

structural member of the feature and select Edit Feature . 
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13 Corner treatment. 

Click the corner marker as shown. In the Corner Treatment dialog, set the Trim 

Order to 2 and click . Repeat the process for the other corner and click  in 

the main dialog. This changes the selections to mitered corners. 

Note: The potential changes that can be made are limited by how the feature was 

created. This feature was created using groups so miters are the only other choice. 

Editing the Trimming 

With the changes to mitered corners, the trimming can now be changed. In this 

case a planar face will be used instead of a body. 

14 Edit trim feature. 

Right-click the face of the structural member shown and select Edit Feature . 

Under Trimming Boundary, click Face / Plane and select the face as shown. 

Click . 
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Editing the Type of Structural Member 

The standard, type or size of the structural member can be changed. In this 

example, structural members that will have plates attached will be changed to 

square profiles. 

15 Edit feature. 

Right-click the face of the structural member shown and select Edit Feature . 

Click FSAE, Type Square Tubes and Size 25mm Sides. Click .

Using Locate Profile 

In creating all of the structural members so far, 

the profiles have been placed directly at the 

default center position. 

Consider a case where structural members of the 

same type and size are stacked on top of one 

another. Is it necessary to sketch a centerline 

offset by the exact amount? 

Locate Profile allows you to place the profile within the sketch using the points 

built into the profile. For more information see “Why Do Some Profiles Contain 

Points?” on page 80. 
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16 Find the parents. 

Right-click a face of the structural member as 

shown and select Parent/Child. The Parents 

and Children of the feature are listed. Click 

Close. 

17 Show sketch. 

Right-click the Lower_Frame_sketch in the dialog and select Show. 

18 New sketch. 

Right-click the top face of the structural member and select Sketch . 
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19 Convert. 

Click Convert Entities  and select the 

centerline of the visible sketch. 

Drag the endpoints outside the structural 

members and exit the sketch. 

Add relations to span the full width as 

shown. 

Close the sketch. 

20 Locate profile. 

Click Insert, Weldments, Structural Member and the following options: FSAE, 

Type Square Tubes and Size 25mm Sides. Select the line and click Locate 

Profile. Click the point at the lower center position on the profile and click . 
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21 Measure. 

Click Tools, Measure and select the two faces shown.

Repeat the measurement on the opposite side to ensure that the structural member 

is centered. 

22 Save. 

Save the part and close it. Return to the assembly and click Yes to rebuild the 

assembly. 
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Using Instant 3D

Instant 3D can be used to make dynamic changes to a model by dragging or 

directly changing dimensions. 

Where to Find It

� CommandManager: Assembly > Instant 3D 

23 Change dimensions. 

Click Instant 3D  and double-click the feature shown. Right-click the Frame 
part and select Edit Part . Double-click the feature and drag the handles on the 

dimensions to resize them to the values 80mm and 300mm as shown.

Single-click a dimension to change 

the value. 

Drag the dimension handle  near 

the ruler to lock onto whole number 

ruler values. 
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Double-click the feature and change the dimensions to resize them to 350mm and 

530mm as shown. 

Checking Clearances 

What is the minimum clearance between the Sprocket and frame? This 
question can be using Clearance Verification  tool. 

24 Edit the Assembly. 

Click confirmation corner  to edit the assembly. 
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25 Clearance. 

Click Tools, Clearance Verification . 

Click Selected Items and select the Sprocket and 
frame. 

Type 0mm in Minimum Acceptable Clearance and click 

Calculate. The clearance is close to 18mm. Click .

Note: A visual check shows that there is no interference between the Sprocket and 
frame components, but they can be checked. For more information, see 

“Interference Detection” on page 102. 
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Fully Defining a Component 

The ENGINE component remains under defined, still able to rotate freely. It 

should be fully defined to prevent inadvertent movement. 

26 Open the ENGINE. 

Right-click the ENGINE component and select Open Part . 

27 Add new plane. 

Click View, Temporary Axes. Add a Parallel plane 

between the selected face and the temporary axis through 

the hole as shown. 

Filtering the FeatureManager Design Tree 

The FeatureManager design tree filter can be used to filter by name. Typing a 

name into the filter will result in a list of only the features, sketches, components 

or mates that use those characters. 

28 Filter. 

Return to the assembly. Click in the filter at the top of the 

FeatureManager design tree and type engine. 

Right-click Engine1_sketch and select Show. 

Click “x” to stop the filter. 
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29 Mate. 

Add a Coincident mate between the plane and the line in the sketch. 
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Interference Detection 

Interference Detection is useful in finding interferences or clashes, between 

static component parts in the assembly. The results show the interfering volumes 

in red. 

Tip: To check interferences between solid bodies in the same multibody part, select the 

multibody part only and click Include multibody part interferences. 

30 Interferences. 

Click Tools, Interference Detection . 

By default, the entire assembly is selected for interference 

detection, so right-click in the Selected Components field 

and select Clear Selections. 

Select the ENGINE and frame components and click 

Calculate. 

A total of four interferences are found combined into two 

symmetrical sets. Click . 

31 Edit sketch. 

Click in the filter at the top of the FeatureManager design tree and as before type 

engine. Right-click the under defined (-) Engine_Mount and select Edit 

Sketch . Click “x” to stop the filter. 

Tip: This is a shortcut that puts you in Edit Part and Edit Sketch mode directly. 
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32 Drag. 

Drag the open endpoint short of the ENGINE 
component. 

33 Dimension. 

Add a dimension between the edge of the 

ENGINE and the endpoint as shown. 

34 Edit assembly. 

Click Edit Component  to exit the 

sketch and return to edit assembly mode. 

Note: The sketch name has changed to Engine_Mount-> denoting that it is fully 
defined and contains external references. 
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Mounting Plates

The frame is currently placed with reference to 
the suspension points, but it is not attached. To 

create an actual attachment, mounting tab plates are 

required. 

Creating a Reusable Sketch

The mounting tabs used to attach the suspension to the frame are plates that are 
rounded on one end. Although all the tabs have a similar shape, the length and 

ends may vary. For this reason, creating a sketch that can be easily copied and 

modified is a good solution. 

1 New part. 

Open a new part with units mm. Create a new sketch on the Front plane. 

2 Geometry and dimensions. 

Create the geometry and dimensions 

using these guidelines: 

1. Create a centerline from the origin 

on a slight angle.

2. Offset the centerline with the bi-

directional option (add dimensions 

off) to create the sides. 

3. Add a tangent arc to close the upper 

end. 

4. Add a line between endpoints to 

close the lower end. 

5. Add a circle. 

6. Add dimensions. 

Note: The centerline is on a slight angle (not horizontal or vertical) and under defined to 

make the placement flexible. 
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3 Drag. 

Drag the lower corner endpoint. The 

under defined sketch should rotate but 

maintain the shape. 

4 Save. 

Save the part as TAB_Sketch. 

Exit the sketch but do not close the part. 

5 Copy sketch. 

Select the Sketch1 feature in the FeatureManager design 

tree and Edit, Copy. 

Pasting the Sketch 

After editing the frame part, the sketch will be pasted onto the face of a 
structural member. 

Tip: A common mistake in this situation is to paste the sketch before editing the part. 

The sketch can be pasted, but is only useful as an assembly feature. An assembly 

feature is a feature that exists only at the assembly level and can only be used to 

create a cut. 

6 Edit part. 

Return to the assembly, right-click the Frame part and select Edit Part . 
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7 Paste. 

Select the face of the structural member as indicated. Click Edit, Paste.

8 Edit sketch. 

Right-click an edge of the sketch and select Edit Sketch . 
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9 Temporary axes. 

Show the temporary axes by clicking View, Temporary Axes. Select the 

centerline and the temporary axis and add a Parallel relation. 

10 Concentric. 

Select the circular edge and the circle and add a Concentric relation. 
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11 Extrude. 

Extrude the sketch 3mm as shown. 

Note: This part has been marked as a weldment , so the Merge Result option in 

extrude remains cleared. 

12 Repeat procedure.

Select the bottom face and create a new sketch. Convert edges from the previous 

body to create the sketch and extrude the sketch 3mm as in the previous step. 

Repeat for the remaining tabs on the same side and mirror. 
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13 Paste sketch. 

Show Engine1_sketch. Select the face, click Edit, Paste and edit the sketch. 
Add a Concentric relation between the arc and circular edge as shown. 

14 Point. 

Add a point on the centerline. Add a Coincident relation between the centerline 

and the point. Use the point to add a Pierce relation between the point and the 

inactive sketch line. 
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15 Trim and extrude. 

Create the front edge of the structural member 

using Convert Entity. Trim the geometry 

leaving the centerline and point intact as 

shown. 

Extrude the sketch 3mm.

16 Plane. 

Click Insert, Reference Geometry, Plane, select the faces and click Mid Plane. 

Rename the plane Centered. 

17 Mirror. 

Mirror the body using the in-context plane. 
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Weldment Cut Lists 

The Cut list folder list of all structural members in the weldment. 

Note: In a non-weldment multi-body part the folder is named Solid Bodies. 

18 Updating the folder. 

Open the part Frame. 
Right-click the Cut list folder and select Update to 
group similar structural members in folders. 
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Cut List Properties 

The Cut-List Properties can be used to view detailed information about the 

individual structural members including lengths and angles. Right-click a 

Cut-List-Item folder and select Properties. 

For example, Cut-List-Item7 the following 
property values and are listed:

LENGTH = 184.21

ANGLE1 = 45.00 

A drawing of the structural member would look like 

this: 
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Save as External File 

The virtual part can be saved externally, creating a part file outside of the 

assembly file. 

Note: You cannot create a drawing of the virtual part until it is saved to an external file. 

19 Edit the Assembly. 

Return to the assembly. 

Click confirmation corner  to edit the assembly. 

20 Save external. 

Right-click the virtual part and select Save Part (in External File). Click Same 

As Assembly and OK. 

Note: The name changes slightly. The braces surrounding the name ([,]) are removed. 

21 Save and close all files. 
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Lesson 4
Using Molds and Surfaces

When you complete this lesson, you will be able to:

� Understand the loft feature; 

� Describe the bodies created using the mold tools; 

� Use surfaces to add to the mold tools; 

� Use symmetry to create additional molds. 
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Molds and Surfaces 

The Mold Tools commands can be used to create the mold tooling for a part. The 

mold tooling is created using a set of surface and solid bodies in the same part. 

Like the weldment, it is a multibody part. 

1 Open assembly. 

Open the assembly Intake Assembly from the Mold folder. 

2 Open assembly. 

Open the assembly Frame&Suspension 
from the 

Lesson 3\Frame&Suspension folder. 
This is the assembly used in the previous 

lesson. 

Add the Intake Assembly assembly to 

the main assembly. Mate the sub-assembly 

using one concentric and two coincident 

mates. 

runner

restrictor

plenum

intake
connection
boot
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3 Open runner. 

Right-click one of the instances of the part runner and select Open Part . 

The runner part 

The actual runner part is created in two pieces, a right and a left, that are later 
assembled into one. Each piece requires a mold. 
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Features in the Part 

The model of the runner part is created using three main boss features: the Bell, 
the Straight Boot Section and the Center Guide Curve. 

The revolve feature named Bell is used to connect the runner 
components to the plenum. 

The extrude feature named Straight Boot Section is used to 
connect the runner components to the intake connection 
boot components. 

This feature must fit inside the intake connection boot. 

The loft feature named Center Guide 
Curve smoothly connects the revolve 

and extrude features. 

For more information about loft features, see “Anatomy of a Loft” on page 118. 

o
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Anatomy of a Loft 

The loft feature is used to transition between different profile shapes. In this 

example, the starting profile is a slot shape that transitions to a circular shape. 

Profiles 

Profiles represent the starting, ending and optionally intermediate shapes along 

the loft. They are closed contour sketches or curves. 

Guides 

A centerline is a guide used to orient the profiles in transition. A guide curve is 

used to shape the loft. Guide curves are open contour sketches or curves. 

Loft with Guide Loft without Guide
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Creating Mold Tooling 

SolidWorks contains a series of mold tools that 

can be used to analyze and create mold tooling 

starting with the molded part. 

If carbon fiber is used, the cavity solid body is 

the desired mold. When the carbon fiber is 

created, the thickness will be applied to the 

inside maintaining the outside dimensions that 

fit into the intake connection boot 
components. 

This example assumes carbon fiber is used. 

Surface and Solid Bodies 

The mold tool procedure creates multiple bodies, including 

sets of both surfaces and solids, in a single part file. For 

more information see “Surface and Solid Bodies” on 

page 119. 

Note: A multibody part, like a weldment, is created. 

Solid Bodies

Surface Bodies
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Description of the Bodies 

Each of the resulting solid and surface bodies are created for a specific purpose. 

They are described below. 

Molded Part Parting Surface

Cavity Solid Cavity Surface 

Core Solid Core Surface 
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Mold Tools 

The mold tools are designed for use with plastic injection molding, but they can 

be adapted for use with other manufacturing methods. The sequence shown here 

is typically used. The result is a multibody part with bodies representing the 

molded part, the core, and the cavity. 

Note: The options scale and shut-off surfaces are not used in this example.

Tip: Most of these tools are on the Mold Tools tab of the CommandManager. Right-

click an existing tab and select Mold Tools to display the tab.

Scale 

Scales the molded part to account for 

shrinkage in some materials. Not used 

in this example. 

Analysis Tools

Draft Analysis  and Undercut 

Analysis  are used to see if the part 

can be removed from the mold. 

Parting Line Analysis  is used to 

visualize potential parting lines. 

Split Line  
Breaks up model faces by adding 

edges. 

Parting Lines 

Uses model geometry to define the 

parting line edges that define the 

parting surface. 

Shut-off Surfaces 

Adds surfaces to close holes in some 

molded parts. Not used in this 

example. 

Parting Surfaces 

Surfaces created from the parting 

lines to separate the mold cavity from 

the core. 

Surfaces 

Many surfaces types can be used to 

supplement or replace the parting 

surface depending on the complexity 

of the model. 

Tooling Split 
Creates both the core and cavity solid 

bodies by splitting a solid. 
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4 Configuration. 

Create a new configuration, Mold, to hold all the mold 

features. Make sure that Suppress new features and 

mates under Advanced Options is checked. The new 

features will be suppressed in the Default configuration. 

5 Draft analysis. 

Click Draft Analysis  and select the Right plane. Set 

the Draft Angle to 1deg and click . 
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What Does This Mean? 

This means that the angle between the Right plane and the 
yellow faces is 1deg or less. It is in fact 0deg because they 

are perpendicular. 

Note: This small undrafted area is not a problem using carbon 

fiber, but it would cause problems for other materials. 

6 Display off. 

Click Draft Analysis . 

7 Undercut Analysis. 

Click Undercut Analysis  and select the Right plane. 

Click . This confirms that the mold should be created in 

two pieces. 
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8 Split line. 

Click Split Line  and click Intersection. Select Right 

plane and the faces that intersect that plane. Click . 

9 Parting line. 

Click Parting Lines , Select Right plane and set the 
Draft Angle to 1deg. 

Click Draft Analysis. 
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10 Edge selections. 

Select the starting edge as shown. 

Click Select Next Edge  (or type “n”) and then Add 

Selected Edge  (or type “y”). 

Continue the selections using the 

selection tools. 

Continue selecting edges to 

complete the loop of selections as 

shown. Click . 
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11 Parting surface. 

Click Parting Surfaces  and select Perpendicular to 

pull. Set the Distance to 30mm and click Knit all 

surfaces. Click Sharp  and click . 

Note: The parting surface is not always large enough to be able to 

split the mold. 

Using Surfaces

Surfaces often must be used to fill in or complete the surface geometry started by 

parting and shut-off surfaces. Here is a partial list of surface tools found on the 

Surfaces tab of the CommandManager.

� Extruded , Revolved 

� Swept , Lofted 

� Planar 

� Ruled 

� Knit 

� Filled 

� Extend , Trim 

� Offset 
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12 Extend edges. 

Click Extend Surface  and select three edges as shown. 

Click Distance, set the value to 30mm and click . 

Repeat the process for five edges on the opposite end. 
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13 Planes. 

Create planes offset 170mm from the Front and 60mm from the Top as shown. 

14 Trim. 

Click Trim Surface  and select Standard. Select the 

Plane3, Keep selections and select inside the plane. 

Click . Repeat the process for the opposite end.



SolidWorks Using Molds and Surfaces
Engineering Design and Technology Series

Creating Mold Tooling 129

15 Sketches. 

Click the parting surface and select Sketch . Using converted entities and lines, 

create the two sketches as shown. Exit both sketches. 

16 Planar surfaces. 

Click Planar Surface  and select a sketch. Press Return 

to repeat the command and repeat the procedure for the 

other planar surface. 
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17 Knit surface. 

Click Knit Surface  and select the three surfaces. Click 

Merge entities and click .

18 Drag and drop. 

Drag and drop the Surface-Knit1 body into the Parting Surface Bodies 
folder as shown. 

Note: The surface must be moved because it was created manually using extend, planar 

and knit surfaces. 
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19 Tooling split sketch. 

Click Mold Tools > Tooling Split  and select the knitted surface as the sketch 

plane. Create the sketch and dimensions as shown. 

20 Tooling split sizing. 

Exit the sketch. Set the Depth In Direction1 and Depth In 

Direction2 to 50mm as shown. Click .
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21 Test measurements. 

Right-click the first (Parting Line1) solid body in the Solid Bodies folder 
and select Isolate. Click Tools, Measure and measure the distance between 

endpoints as shown. The key dimension is Dist 56.45mm as shown. 

22 Exit isolate. 

Click Exit Isolate on the Isolate dialog. 

23 Isolate cavity solid. 

Right-click the third solid body in the Solid Bodies folder and select Isolate. 
The key dimension is the again Dist 56.45mm as shown. 

This shows that the outside faces are used to create the mold. Click Exit Isolate. 
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Making Use of Symmetry 

Individual bodies can be saved into new part files. This creates an external 

reference from that single body to the part file. 

The other half of the mold is symmetric to the current one. It can be created using 

a mirrored part. The mirrored part is derived from the original part but mirrored 

using a plane or planar face. 

runner -> mirrored part 

Note: The if the other mold is not symmetrical to the first, a similar procedure can be 

followed using slightly different selections in the Parting Line feature.

24 Stock feature. 

Right-click the cavity solid body in the Solid Bodies folder of the 
FeatureManager design tree and click Insert into New Part. Use the name 

runner-Cav_1. A stock feature Stock-runner-1 is created. 

runner-> runner-Cav_2->runner-Cav_1->
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25 Mirror part. 

Select the Right plane and click Insert, Mirror Part. Click 

Solid bodies, Surface bodies and Planes. Click . 

Use the name runner-Cav_2. 

26 Holes. 

Return to the runner part. Select the outer face and click 

Insert, Features, Hole, Wizard . Add 10mm through 

all holes placed as shown and select the two mold bodies 

with the Feature Scope. Click . 
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27 New assembly. 

Create a new assembly and add the runner-Cav_1 and runner-Cav_2 parts. 
The holes have been transferred to these parts using the external references. 

28 Save and close all files. 
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Lesson 5
Brake Rotor Analysis

When you complete this lesson, you will be able to:

� Set up and run a thermal analysis;

� Post process thermal results;

� Set up and run a static analysis;

� Apply thermal loading to structural analysis;

� Post process static analysis.
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Brake Rotor Design

When a vehicle is in motion, it is said to have 

kinetic energy. Brakes are designed to stop the 

vehicle by absorbing the kinetic energy of the 

vehicle and dissipating it in the form of heat.

The kinetic energy of a vehicle is given by the 

following equation:

where m is the mass of the vehicle and v is the velocity of the vehicle. If the mass 

of the vehicle is large, or the velocity is large, this can amount to a large amount of 

energy dissipated in the form of heat. The braking mechanism must be able to 

withstand both the temperatures generated by this heating as well as the forces 

incurred during breaking.

In this lesson, we will investigate the design of the braking rotor. The vehicle will 

be moving at full speed and will be braked to a complete stop. First, a thermal 

analysis will be run to calculate the temperature distribution in the brake rotor 

during braking. Next, a static analysis will be run to see the affect of the thermal 

load as well as the forces that come with the brake pads.

1 Open Brake Rotor Assembly. 
Click File, Open and select the assembly Brake Rotor Assembly. Click 
Open to open the assembly.

Activate the configuration called Split Line. It contains the model with 

necessary changes so that we can run the analysis properly.

2 Start SolidWorks Simulation.

Click Tools, Add-Ins. Select SolidWorks Simulation.

Click OK.

KE
1

2
---mv2=
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SolidWorks Simulation Interface

SolidWorks Simulation functions are accessed in the same way as SolidWorks. 

When a simulation study is created, a Simulation Study tree appears beneath the 

FeatureManager design tree. Each new study that gets created is represented by a 

tab at the bottom of the screen. Like SolidWorks functions, Simulation functions 

can be accessed from the Simulation toolbar, CommandManager, or Simulation 

drop-down menu. Additionally, functions can be selected by right-clicking 

geometry or items in the Simulation Study tree.

Simulation

Toolbar

Simulation 

Analysis Library

Simulation Study

CommandManager tab

Study tree

tabs

Advisor
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3 Create a study.

From the Simulation drop-down menu, select Study.

Select Thermal as the Type.

Enter Temperature Distribution as the Name.

Click .

The FeatureManager design tree will split and a Simulation 

study tree will be created below the FeatureManager design 

tree.

The setup of the study is done using the Simulation study 

tree.

4 Adjust study properties.

Right-click the study name at the top of the Simulation 

study tree and select Properties.

Under Options, select Transient and enter 3 sec as the 

Total time.

Click OK.
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Transient Thermal Analysis

This model is run as a transient analysis because we want to study the heat 

distribution during braking from a speed of 22 m/s to a complete stop. We can 

easily calculate the time it takes to stop by first calculating the force it takes to 

stop the vehicle. We know that the vehicle is 275 kg and we assume the coefficient 

of friction between asphalt and rubber is 0.72. To stop the vehicle in the shortest 

time, the maximum braking force can not be larger than the maximum friction 

force between the tires and the ground, which can be transmitted to the ground. 

This maximum friction force is calculated as follows.

Now that we know the friction force, we can calculate the average acceleration of 

the car during braking.

Finally, we can calculate the time it takes to stop.

5 Apply material.

Right-click the Parts folder and select Apply Material to All.

Select Gray Cast Iron under Iron as the material. Click Apply, then Close.
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Thermal Boundary Conditions

SolidWorks Simulation solves for the temperature distribution in the solid using 

the conduction equations and boundary conditions applied to the boundaries of the 

model. SolidWorks Simulation has several thermal boundary conditions that can 

be applied to thermal studies.

� Temperature

Allows for the definition of a temperature on a certain entity or body.
� Convection

Applies a convection boundary condition to the selected faces. The 

convection coefficient and ambient temperature are specified and the heat lost 

due to convection is calculated automatically.
� Heat Flux

Applies some amount of heat into a face per unit area.
� Heat Power

Applies some amount of heat to a vertex, edge, face or component.
� Radiation

Allows surface-to-surface or surface-to-ambient radiation.

In our model, we will apply convection to all faces because all of the faces will be 

exposed to the air. In addition, we will apply a heat power to the faces that the 

brake pads touch.

Convection

Convection is the transfer of thermal energy between a surface and a fluid. The 

amount of heat transferred through conduction is proportional to the convection 

coefficient, h, the surface area, A, and the temperature difference between the 

surface and the surrounding fluid.

In this lesson, we will assume a convection coefficient of 90 W/m^2.K and an 

ambient temperature of 20°C, which are approximations. Actual convection 

coefficients and ambient temperature could be computed by running a CFD 

analysis in SolidWorks Flow Simulation or from experiments.

Qconvection hA Ts Tf–( )=
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6 Apply thermal load.

Right-click Thermal Loads in the Simulation 

Study tree and select Convection.

Select Select all exposed faces in the 

Convection PropertyManager. This will choose 

all of the exposed faces for the convection 

boundary condition.

Enter 90 W/m^2.K as the Convection Coefficient.

Enter 293 Kelvin as the Bulk Ambient Temperature.
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7 Edit Time Curve.

Click Use Time Curve and select Edit.

Column X denotes the time and column Y denotes the multiplication factor that 

will be applied to the convection coefficient that was entered.

Enter (0, 1) and (3, 1) in the table. This will represent the convection always being 

turned ON.

Click OK.

Click .

Note: Similar to the time dependence of the loading using time curves, any thermal load 

can be made temperature dependent using temperature curves. Solutions with 

temperature curves are significantly more time consuming as convergence 

iterations are required because each finite element can generate a different level of 

heat power based on its average temperature.
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Heat Power

As the vehicle is braked, the rotor is spinning and the brake pads are rubbing 

against the surface of the rotor, creating friction and heat energy. Much of the 

kinetic energy of the car is being transferred to thermal energy through the brake 

pads. The heat power will be applied to the brake rotors in the area that the pads 

touch.

The amount of heat power can be calculated from the amount of kinetic energy 

carried by the car. If we assume the mass of the car is 275 kg and the car is 

travelling at 25 m/s, the kinetic energy of the car is as follows:

If we assume all of that kinetic energy is transferred to thermal energy during 

braking that lasts 3seconds, we can calculate the heat power.

Since we will analyze only one pad, and about 60% of the mass of the vehicle will 

be on the front, the heat power is reduced.

8 Apply thermal load.

Right-click Thermal Loads in the Simulation Study tree 

and select Heat Power.

Select the four faces of the rotor that the brake pads touch.

Enter 6660 W as the Heat Power.

Select Total.
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9 Edit Time Curve.

Click Use Time Curve and select Edit.

Column X denotes the time and column Y denotes the multiplication factor that 

will be applied to the heat power that was entered.

Enter (0, 1) and (3, 1) in the table. This will represent the heat power always being 

turned ON.

Click OK.

Click .

10 Initial temperature.

Right-click Thermal Loads in the Simulation Study tree and select 
Temperature.

Select Initial temperature.

Select the assembly from the fly-out FeatureManager design tree.

Enter 25 C as the Temperature.

Click .



SolidWorks Brake Rotor Analysis
Engineering Design and Technology Series

Post Processing 146

11 Mesh the model.

Right-click Mesh in the Simulation Study tree 

and select Create Mesh. Use Curvature based 

mesh and default element size.

Click .

12 Run the study.

Click Run from the Simulation drop-down menu.

Note: The study should take several minutes to run. A calculation is performed at each 

time step as specified in the study properties. Results will be available for each 

time step performed.

Tip: Be careful when specifying the time step magnitude so that accurate resolution of 

your loading curve is obtained.

Post Processing

We will now look at the various post processing options associated with transient 

thermal analysis.

13 Plot Temperature distribution.

Right-click the Thermal1 plot of the temperature 

distribution and select Edit Definition.

Change the Units to Celsius.

Make sure the Plot Step is set as 30.

Click .
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14 Probe.

Right-click on the temperature plot in the Result folder 
and select Probe.

Select any location on the brake rotor.

Click the Response button  under Report Options.

A plot of temperature vs. time will appear.

Click .

Note: You can do this with any of your created plots in a transient thermal analysis.
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15 Plot Resultant Heat Flux.

Right-click Results in the Simulation Study tree and select Define Thermal 

Plot.

Select HFLUXN: Resultant Heat Flux as the Component.

Make sure the Plot Step is set as 30.

Click .

Tip: You can also select Plot Bounds across All Steps from the 

Plot Step menu. This will look through all solution time 

steps and plot the maximum or minimum values.

Note: You can also plot the temperature gradient. In addition, you 

can plot the directional components of each thermal result 

quantity. You are encouraged to try these plots.

Static Study

We now know the temperature distribution after the vehicle brakes from 22 m/s to 

a complete stop. This temperature distribution will be transferred into our static 

study as a thermal loading condition and the material will be allowed to expand or 

contract as a result of the temperature distribution. In addition, we will apply a 

loading condition to simulate the load that the brake pad would apply to the rotor. 

We want to insure that the brake pad will not warp significantly during this 

extreme braking situation.
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16 Create a study.

From the Simulation drop-down menu, select Study.

Select Static as the Type.

Enter Thermal Stress as the Name.

Click .

17 Apply material.

Right-click the Parts folder and select Apply Material to All.

Select Gray Cast Iron under Iron as the material. Click Apply, then Close.

Tip: You can also copy the materials from the thermal study by selecting the Parts 
folder in the thermal study, then drag and drop it onto the static study. Other study 

parameters can be copied similarly.

Temperature Dependent Material Properties

Material properties are often temperature dependent. You can make your material 

properties temperature dependent in SolidWorks Simulation by creating a custom 

defined material and selecting Temperature Dependent under where you enter 

the parameter value.

Fixtures

The fixtures in your study will represent how the structure is attached to the real 

world. It is always best to pick the type of fixture that best represents the 

attachment to the real world. The following type of fixtures are available in 

SolidWorks Simulation:

� Fixed Geometry

Fixes all degrees of freedom. Also known as a rigid support.
� Roller/Slider

Specifies that a planar face can move freely in the plane, but is restrained 

normal to the plane.
� Fixed hinge

Can be applied to a cylindrical face and only allows movement about the axis 

of the cylindrical face.
� Advanced Fixtures

Allows for different types of restraints in various directions. Feel free to 

review the help menu to investigate these types.



SolidWorks Brake Rotor Analysis
Engineering Design and Technology Series

Fixtures 150

18 Apply fixture.

Right-click Fixtures in the Simulation 

Study tree and select Fixed Geometry.

Select the face on the inner diameter of the 

rotor hub where it would be mounted to a 

shaft.

Click .

Note: We are applying a rigid restraint to the shaft mounting location. With this, comes 

the assumption that the shaft will not deform under any applied loading 

transferred through this mounting location. For this example, we are assuming the 

shaft is much more rigid than the rotor hub. If we expect the shaft to deform, we 

would need to include it in the analysis.

19 Apply fixture.

Right-click Fixtures in the Simulation 

Study tree and select Roller/Slider.

Select the split face on one side of the rotor 

where the fixed brake pad will rub the rotor.

Click .

Discussion

Typically, the brake calipers are designed such that one pad applies a load to the 

rotor to push it into the other pad. With this restraint, we are simulating the 

stationary pad and assuming that the pad will not deform under the loading. We 

will now apply the loading.
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Loading

Like the fixtures, the loading in your structure should best represent the in-service 

loading conditions. The following types of structural loading is available in 

SolidWorks Simulation.

� Force

Applies a force to an edge, face, or vertex in the direction defined by 

reference geometry.
� Torque

Applies a torque about a reference axis.
� Pressure

Applies a pressure to a face.
� Gravity

Applies linear acceleration to parts or assemblies.
� Centrifugal Force

Applies an angular velocity and acceleration.
� Bearing Load

Defined between contacting cylindrical faces.

20 Apply load.

Right-click External Loads in the Simulation Study tree 

and select Pressure.

Select the split face where the brake pad will push against 

the rotor.

Enter 1e6 N/m^2 as the Pressure Value. This value can be 

known from experiments.

Click .
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Braking Force

In addition to the load applied to the rotor through the brake pad, there is also a 

frictional component of the braking force in the circumferential direction. If we 

know the normal load applied to the bracket (1 MPa) and the friction coefficient 

between the rotor and pads (0.6), the frictional force can be calculated using the 

area of the pad application.

Note: The frictional coefficient between the pad and rotor can often vary depending on 

the temperature. Using 0.6 as the friction coefficient is a simplification made in 

this example.

21 Apply load.

Right-click External Loads in the Simulation Study tree 

and select Force.

Select the two split faces on the rotor where the brake pads 

make contact.

Select Selected Direction.

Select Axis1 of the Rotor Hat part as the reference.

Select the Circumferential direction and enter 497 N.

Click .

Note: When an axis is selected as a reference, the coordinate system changes to 

cylindrical coordinates and our load can be applied circumferentially.
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Thermal Loading

Now that the structural loadings have been applied, we need to apply the thermal 

loading. We want to apply the maximum amount of thermal loading seen during 

the braking. This is obviously the temperature distribution at the end of the 

braking. The temperatures solved for in the thermal study will then be transferred 

to the static study and the material will be able to respond to the change in 

temperature. This will cause additional displacement and thermal stresses to 

develop in the structure.

22 Adjust study properties.

Right-click the study name at the top of the Simulation study tree and select 
Properties.

Select the Flow/Thermal Effects tab.

Select Temperatures from thermal study and select Temperature Distribution, 

Time step 30 as the Thermal study.

Enter 298 Kelvin as the Reference temperature at zero strain.

Click OK.

The Thermal load will appear in the External Loads folder.
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23 Mesh the model.

Right-click Mesh in the Simulation Study tree 

and select Create Mesh. Use Curvature based 

mesh and default element size.

Click .

24 Run the study.

Click Run from the Simulation drop-down menu.

Post Processing

We will now learn about the various post processing options available for static 

studies.

25 Plot stress.

Activate the Stress1 plot by double-clicking it from the Results folder. It is a 
plot of the von Mises stress in the model.
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Editing Plots

To edit a plot, right click on the plot and select Edit 

Definition.

The Display dialog lets you specify a stress component and 

units.

The Advanced Options lets you choose to plot either a 

Node or Element value. For the nodal values, the stresses 

are averaged and displayed at the nodes. For the elemental 

values, the stresses in a given element are averaged and the 

element is given this averaged stress and it is displayed.

The Show as tensor plot option allows you to plot the 

orientation as well as the magnitude of the stresses.

The Deformed Shape dialog allows you to show the 

deformed shape and to choose the scaling of the graphics 

window.

Chart Options

The chart options can be accessed by 

right-clicking on the plot and selecting 

Chart Options or by double-clicking 

the legend. The chart options control 

the annotations as well as other options 

such as the color, type of units 

(scientific, floating, etc), number of 

decimals shown in the legend.

Settings

The plot settings can be accessed by 

right-clicking on the plot and selecting 

Settings. They are used to control 

various display options.
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26 Display model maximum.

Right-click on the plot and select Chart Options.

Click Show max annotation.

Click .

Discussion

Notice that the maximum occurs in a sharp corner where the mesh is quite coarse. 

If stresses are of interest in this location, significant mesh refinement would be 

required. In addition, this may be an area of singular stress due to the boundary 

conditions and the sharp corner. If this was the case, this stress value could be 

ignored.
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27 Plot displacement.

Double-click the Displacement1 plot to show the displacement plot.

Conclusions

In this lesson, we did an analysis of a brake rotor. We learned how to set up and 

run both a thermal and static study. We also learned about some of the post 

processing options available in SolidWorks Simulation.

In order to perform this analysis, some significant assumptions were made. First 

of all, the convection was assumed a constant 90 W/m^2.K throughout the 

analysis. This is a bit of an aggressive assumption due to the fact that as the car 

slows down, there will be less air flow over the rotor, therefore less heat lost due 

to convection. As mentioned before, SolidWorks Flow Simulation could be used 

to more accurately calculate the convection around the rotor.

Another assumption made in this modeling is that the heat power is applied to the 

entire rotor surface rather than simply the location the pad touches. In actuality, 

the heat power is only generated where the pad touches, and as the car moves, this 

location rotates around the entire surface of the rotor. By applying it to the entire 

rotor surface, we “smear” the heat power evenly along the surface in what could 

be considered a conservative assumption. Can you think of a way to apply the heat 

power to better match the real model?

Additional assumptions were made in this model such as the friction coefficient, 

material properties, and structural boundary conditions. Therefore, this analysis 

should serve as a first-pass type of analysis where further testing or investigation 

could be done for more conclusive results.
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Lesson 6
Frame Analysis

When you complete this lesson, you will be able to:

� Set up an analysis using beam elements;

� Create truss elements;

� Calculate the torsional rigidity of your frame;

� Post process results in cylindrical coordinates;

� Define beam shear and moment diagrams;

� Evaluate your frame design.
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Torsional Rigidity

The torsional rigidity is defined as the torsional 

response (defined as some deflection angle) of a 

structure to an applied torque loading. The image 

to the right shows the deformation of a structure 

due to some applied torque loading. The torsional 

rigidity would be mathematically formulated as 

follows:

With respect to frame design, the torsional rigidity is an important characteristic 

of the vehicle for several reasons. As we will see, the general rule of thumb for 

torsional rigidity is “the stiffer, the better.” 

Imagine strapping wheels to a mattress and trying to drive the mattress through 

twists and turns. A mattress car, as you can imagine, would not handle the lateral 

loading well and it would be very difficult to keep the wheels of the car on the 

ground. Torsional stiffness drastically affects the car’s handling.

The lateral loading on a vehicle is taken up in two places; the frame and the 

suspension. Now, consider tuning the torsional stiffness of your car to drive on 

different road types. The suspension can be adjusted, the frame cannot. Ideally 

then, your suspension will take up much of the lateral loading. Adjusting the 

stiffness of your suspension will determine how the car handles different types of 

loading. If the loading is taken by the frame, it will be very difficult to tune the 

torsional stiffness of your car.

In this lesson, we will use SolidWorks Simulation to evaluate the torsional rigidity 

of our frame design. Perhaps most importantly, we will also be able to evaluate 

how design changes affect the torsional rigidity (i.e. is this design stiffer or more 

flexible than the previous?).

Element Types

To this point, we have used SolidWorks Simulation to analyze the thermal and 

structural characteristics of our brake rotor using solid elements. Solid elements 

worked well in the analysis of the rotor because the structure was relatively thick 

and our computer had the necessary resources to mesh and run the analysis.

In this lesson, we will be analyzing the frame structure that we modeled in a 

previous lesson. We could use solid elements in this analysis, however we will see 

another element type that will allow us to greatly simplify our calculations.

TorsionalRigidity
TorqueLoad

AngularDeflection
--------------------------------------------------=
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Shell Elements

When the structure becomes thin in one direction, such 

as a sheet metal part, SolidWorks Simulation can use 

shell elements to significantly simplify the calculations. 

The shell element in SolidWorks Simulation is a two 

dimensional triangular element. Each node of the shell 

element features six degrees of freedom (3 

translational, 3 rotational), giving the nodes the ability 

to transfer moments. The thickness of the geometry is 

taken into account automatically in the formulation of 

the element.

Shell elements can be created in SolidWorks 

Simulation the following ways:

� Shell elements are automatically created in 

SolidWorks Simulation when a sheet metal part is used.

� If any surface geometry exists in your part, SolidWorks Simulation will 

automatically recognize them as shell elements as well.

� To manually define shell elements, you can right-click the solid body from the 

Parts folder of the Simulation Study tree and select Define Shell By 

Selected Faces.

Beam Elements

The beam element is another type of structural 

element available in SolidWorks Simulation. It is a 

one dimensional element with 2 nodes. Like shells, 

each node of a beam element has six degrees of 

freedom. The cross-sectional characteristics of the 

beam are taken into account in the formulation of the 

element. These characteristics are automatically 

computed in the software, therefore greatly 

simplifying the model setup.

Beam elements can be created in SolidWorks 

Simulation in the following ways:

� Beam elements are automatically created in 

SolidWorks Simulation when a weldment part is 

used.

� Right-click the solid body in the 

Parts folder of the Simulation Study 

tree and select Treat as Beam.
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Preparing for Analysis

As previously discussed, the first step in the analysis process is to simplify the 

model. Care must be taken when simplifying the model such that we do not 

remove something that could have a significant effect on our results.

1 Open Frame. 
Click File, Open and select the part Frame. Click Open to open the part.

This is the Frame part that was created in the previous lesson. There are a couple 
of modifications to the model in order to make it a bit more convenient for 

meshing.

Tip: The model used for finite element analysis is often simplified from its final 

production state. Therefore, it is often beneficial to have multiple configurations 

of your models, one for analysis and one for production.

2 Add a configuration.

From the ConfigurationManager, right-click 

the part and select Add Configuration.

Type FEA as the Configuration name.

Click .

The new configuration will be created and 

activated in the ConfigurationManager. We 

can now suppress unwanted features in our part that are unnecessary for our 

analysis.

In addition, there may be features to unsuppress that are not part of the final 

model, but are necessary to the analysis.

Note: In this model, we are doing an analysis on a part. If we were analyzing an 

assembly, it would be necessary to create the alternate configurations at the part 

level, then have these configurations active or inactive in the separate 

configuration at the assembly level.

3 Suppress features.

In the previous lesson, mounting locations were created for the suspension and the 

engine. In the analysis, these will not have any affect on the torsional stiffness of 

the vehicle.

Right-click on the Tabs folder and select Suppress.

Right-click on the EngineMount feature and select Suppress.
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Experimental Design

It is important when preparing a finite element model to consider the physical 

representation of what you are trying to analyze. Loading and fixtures are going to 

be applied to the model based on the most accurate representation of the physical 

model. These boundary conditions will introduce assumptions into the model and 

it is critical that the assumptions are understood and reasonable with respect to 

what the model is trying to accomplish.

There are a number of techniques for experimentally measuring torsional rigidity. 

In the simulation, we will try to most accurately represent the experiment in the 

analysis setup. In the experiment, the front and rear wheels are mounted on beams 

and the suspension components are assumed to be fixed so that all of the load 

applied is transferred to the frame itself. The rear of the vehicle is held stationary 

(fixed) while a load is applied to the beam with the front wheels to simulate the 

torque as shown in the figure below.

Note: Our analysis will be setup with respect to this method for measuring torsional 

rigidity. Other methods exist and you would want to design your analysis 

according to the physical setup of the experiment in order to compare the results 

properly.

ForceForce
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4 Unsuppress features.

In this model, the suspension has not been 

included in the analysis. We need a 

location to apply our torque loading as 

well as a place to measure the angular 

displacement for calculating the torsional 

rigidity. For this, beam members have 

been created to connect the frame to the 

location where the wheel is mounted.

Right-click on the Rigid_Supports 
folder and select Unsuppress.

We are now ready to begin the analysis. Make sure that the SolidWorks 

Simulation Add-In is active from the Tools, Add-Ins menu.

5 Create a study.

From the Simulation drop-down menu, select Study.

Select Static as the Type.

Enter Torsional Rigidity as the Name.

Click .

Beam Meshing

As mentioned before, weldment features are 

automatically treated as beam elements in 

SolidWorks Simulation. If solid elements 

are desired for the analysis, right-click the 

beam feature in the Simulation Study tree 

and select, Treat as Solid.

6 Examine the Frame folder.
The Frame folder should contain sub-folders 
that list all the solid bodies that will be meshed 

as beams. You can tell that bodies the will be 

beams because of the beam icon  next to the 

body name. 

Any Solid Bodies that will be meshed as solids should be excluded from the 

analysis. To do this, right-click the solid body and select Exclude from analysis.
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Section Properties

We mentioned that all of the cross-sectional characteristics of 

the beam are taken into account automatically by SolidWorks 

Simulation. The section properties that are not computed 

automatically are constants for the torsional shear and shear 

due to bending calculation. These constants must be entered 

manually if this information is required from the analysis. To 

enter the constants, right-click the beam and select Edit 

Definition. The required contacts for torsional shear 

calculations are as follows:

� Torsional Constant, K

The value for the torsional constant can be calculated or 

obtained from literature.
� Distance for Maximum Shear

Distance from the center of the section to the point of maximum torsional 

shear.
� Shear Factor in direction 1

Shear factor to account for non-uniform shear stress in direction 1 of the beam 

coordinate system. 
� Shear Factor in direction 2

Shear factor to account for non-uniform shear stress in direction 2 of the beam 

coordinate system. 

End Conditions

At the end of each beam falls a node that will connect to 

either another beam joint or a boundary condition. As 

previously mentioned, the nodes of beams have six degrees 

of freedom (three translational and three rotational). These 

degrees of freedom may be restrained or released to reflect 

various structural connection configurations. To manually 

configure these degrees of freedom, right-click the beam 

and select Edit Definition. The graphics window will show 

the beam with two ends as shown in the figure.
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The following options are allowed for beam end conditions:

� Rigid

All six degrees of freedom are tied to the joint. All translational forces and 

rotational moments will be transferred from the beam element to the joint and 

vice versa.
� Hinge

Three translational degrees of freedom are tied to the joint. All translational 

forces will be transferred from the beam element to the joint and vice versa. 

Rotational moments will not be transferred.
� Slide

Three rotational degrees of freedom are tied to the joint. All rotational 

moments will be transferred from the beam element to the joint and vice 

versa. Translational forces will not be transferred.
� Manual

A custom defined connection can be defined.

Trusses

In the same location, the beam can be defined as a Truss  which can only resist 

axial loading.

We want to apply the torsional loading to the location where the wheels would 

mount so that we can best represent the experiment. Weldment features were 

created that defined this location. We want the loading to be transferred directly to 

the joints of the frame where the suspension mounts, however, we do not want any 

moments to transfer, only forces. To only allow the transfer of forces, we will 

make these members trusses.

7 Define trusses.

Select one of the truss members in the 

graphics window. It should highlight the 

member in the Frame folder of the 
Simulation Study tree.

Right-click the member in the Simulation 

Study tree and select Edit Definition.

Select Truss as the Type.

Repeat this procedure for the seven 

remaining truss members that mount to the 

suspension mounting points.

8 Apply material.

Right-click the Frame folder and select Apply Material to All Bodies.

Select Alloy Steel as the material. Click Apply, then Close.
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Joint Group

The beam mesh is made out of a series of one 

dimensional lines that may be connected. The end 

points of these lines are called joints. SolidWorks 

Simulation automatically detects the joint positions, 

however some joints can be very close and it could be desirable to merge them (or 

un-merge) them. In this case, the joint locations can be modified manually using 

the Joint Group. We will practice this in this lesson.

The beam joints are shown as yellow or magenta spheres in the graphics window.

�  joints are connected to two or more beam members.

�  joints are connected to a single member.

9 Edit Joint Group.

When a beam is defined in SolidWorks Simulation a folder 

called Joint Group is created in the Simulation Study 

tree.

Right-click the Joint Group folder and select Edit.
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10 Examine joints.

Right-click a joint icon to examine the 

beams that are connected by the joint.

To add or remove a beam member from 

the list, click the beam in the graphics 

window.

To save the new joint, simply close the 

Select Joint Members window.

11 Edit joint.

Examine the joints in the rear of the vehicle frame. 

Notice that at one of the rear suspension mounting points, there may be two joints. 

This location should only have one joint that connects all of the beams.

Right-click one of the joints and add the omitted beams.

Right-click the other joint and remove all of the beams. This will delete that joint 

since it is redundant.

Click Calculate to recalculate the joints.

Note: This procedure may be repeated as necessary until the joints are calculated 

properly. Additionally, this procedure may not be necessary if the joints are 

initially calculated correctly.

Tip: Be sure to check your joints to insure that they have been computed accurately by 

the software. It can be helpful to thoroughly examine the mesh after meshing.
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Merging Joints Automatically

The software automatically calculates joint locations 

based on the ends of beams. At the joint end, a 

hypothetical sphere is drawn with a diameter chosen 

automatically with respect to the model geometry. If two 

joints fall within one sphere, the beam ends will be 

merged forming one joint. It is possible to modify the 

diameter of this hypothetical sphere using Treat as joint 

for clearance less than. Re-calculating the joints is 

necessary to get them to merge.

Fixtures

SolidWorks Simulation has a number of different fixtures 

that can be applied to beam joints:

� Fixed Geometry 

Fixes all six degrees of freedom (translational and 

rotational).
� Immovable (No translation) 

Fixes translational degrees of freedom only. Rotational 

degrees of freedom are left unconstrained.
� Use Reference Geometry

The user can specify a reference and choose which 

degrees of freedom are fixed (translational or rotational) 

with respect to that reference.

It was mentioned that in the experiment, the rear wheels are held stationary. To 

measure the torsional rigidity, the entirety of the load must be transferred directly 

to the frame. Therefore any components attached to the frame that transfer the 

load must be assumed to be rigid. If this is the case, it would make sense to fix the 

rear joints where the rear suspension would attach.
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12 Apply fixtures.

Right-click Fixtures in the Simulation Study tree and 

select Fixed Geometry.

Select the eight joints at the rear of the frame where the 

suspension would mount.

Click .

Note: You can tell which degrees of freedom are 

being fixed by viewing the arrows. An arrow in 

a given direction means that the translation in 

that direction is restrained. If the arrow has a 

tail, the rotation about that direction is 

restrained as well.
ImmovableFixed Geometry
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Loading

SolidWorks Simulation allows for the application of forces 

and torques to beams or beam joints. The force is applied to 

the beam or joint and the direction is defined by choosing a 

reference.

As with our fixtures, we will assume that the loading from 

the experiment is transferred directly to the frame beam 

joints at the suspension mounting points.

With the wheel structure assumed rigid, the load would be 

applied to the front axle axis and the frame would rotate 

about the center of the frame on the front axle axis. This is 

the location where the angular displacement must be 

measured about.

To simplify the analysis, we have not included our suspension components, 

therefore we must define representative loading condition that will simulate our 

experiment. The application of our loading to our truss members will transfer the 

equivalent torque to the frame through the suspension mounting points. 

Note: The truss members are used only in the finite element model to directly transfer 

the loading. They are not part of the actual frame design.

Rotation Point

Force

Force
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13 Apply loading.

Right-click External Loads in the Simulation Study tree, 

and select Force.

Select Joints under Selection.

Select the beam joint at the termination of the truss 

members.

Select the Front plane as the reference.

Select Normal to Plane and enter 169.7 N.

Click .

Repeat this procedure for the opposite side. 

Make sure that the direction is reversed on the opposite side.

Note: The loading magnitude was calculated such that a 100 N-m torque is applied to 

the frame.

Force
100Nm

0.5892m
---------------------=
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14 Mesh the model.

Right-click Mesh in the Simulation Study tree and select Create Mesh.

The beam mesh will automatically be created.

Note: Truss members are meshed as a single element because they will not have bending 

deformation since their nodes only transfer axial forces.

15 Run the study.

Click Run from the Simulation drop-down menu.

Post Processing

After the study is run, the Results folder in the Simulation Study tree will 

become active and our results are accessible. In this lesson, we will investigate the 

different post processing options available for beams.

The first result that we would like to compute 

is the torsional rigidity. To do this, we must 

know the angular deformation of the frame as 

a result of the torsional loading.

y
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Cylindrical Coordinates

By default, SolidWorks Simulation plots the results using a 

cartesian coordinate system. Knowing this, one could 

convert the results to another, more desirable coordinate 

system.

SolidWorks Simulation also allows for the plotting of 

results in cylindrical coordinate. We will use this method to 

measure the angular deformation of the frame required to 

calculate torsional rigidity.

To change to cylindrical coordinates, a reference axis must 

be selected in the Advanced Options. When in cylindrical 

coordinates, the following changes are made to the 

coordinates with respect to the selected reference axis:

� X direction = Radial direction

� Y direction = Circumferential direction

� Z direction = Axial direction

In addition, the cylindrical coordinate system appears at the bottom 

right of the graphics window to inform you of your coordinate 

selection.
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16 Plot angular displacement.

Right-click the Results folder and select Define 
Displacement Plot.

Select UY: Y Displacement as the Component.

Expand the Advanced Options and select Axis2 as the 
reference.

Select the Automatic scaling.

Click .

Note: The unit system of this plot is still in mm where we might expect it to have an 

angular unit since it is a circumferential displacement. In actuality, the software is 

taking the angular deformation about the axis and multiplying it by the distance 

away from the axis. To compute the actual angular deformation, we need to divide 

by its distance away from the axis.
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17 Probe.

Right-click the Displacement plot in the Results 
folder and select Probe.

Select one of the ends of the trusses where the load 

is applied.

We now know the angular deformation of the end of the frame.

We must divide this by the distance away from the axis to measure the angle.

Click .

Note: The angular deformation will always be calculated in radians, not degrees.

Torsional Rigidity

We can now calculate the torsional rigidity of the frame.

ψ 3.306mm

589.2mm
---------------------- 0.00561rad==

τ 100Nm

0.00561rad
---------------------------- 17825

Nm

rad
---------==
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Beam Stresses

There are a number of different components of stress that develop in beams. 

Axial, torsional, shear, and bending stresses are all components of stress seen by 

beams. In SolidWorks Simulation, you can plot any of these.

By default, SolidWorks Simulation creates a stress plot called Axial and bending 

which looks at each beam element and plots whichever component of stress is the 

highest in the plot. This type of plot is useful in evaluating the maximum stress 

seen in your beams.

18 Plot stress.

Activate the Stress1 plot that was created by default by SolidWorks Simulation.

This is a plot of the highest stress (axial or bending) in each beam element.

We can view these stress components separately.
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19 Plot axial stress.

Right-click the Results folder and select Define Stress 
Plot.

Select Axial and Automatic. 

Click .

Notice that some members are in tension and some members are in compression. 

You can use this information in design change decisions.

Cross Section Directions 1 and 2

To post process bending and shear stress, the beam directions 1 and 2 must be 

defined. SolidWorks Simulation defines direction 1 to be along the longest side of 

the cross section and direction 2 is it’s perpendicular.
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20 Plot bending stress.

Right-click the Results folder and select Define Stress Plot.

Select Bending in local direction 1 and Automatic.

Click .

Note: If you probe on one of the truss members, you will see that it has zero bending 

stress. This makes sense because the trusses do not transfer moments.

Similarly, the user can plot Torsional, Shear in DIR 1 and Shear in DIR 2 

stresses.
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Shear and Bending Diagrams

SolidWorks Simulation also has the ability to plot shear and bending diagrams in 

the different beam directions. These can be used to study how the internal bending 

moments and shear forces vary along the length of the beam.

21 Plot bending moment.

Right-click the Results folder and select Define 
Beam Diagrams.

Select Moment in Dir1.

Under Selected Beams, choose Select and 

select the beam member shown at the front of the 

frame.

Click .

22 List beam forces.

Right-click on the Results folder and select List Beam Forces.

Click .

A list of the forces in each beam element are listed. You can save this list to be 

used later.



SolidWorks Frame Analysis
Engineering Design and Technology Series

Conclusion 180

Conclusion

In this lesson, we evaluated the torsional rigidity of our frame design. We learned 

how to set up an analysis using beam element. We also learned about the various 

post processing options available when beams are used.

At this point, it could be advantageous to change the frame design and re-evaluate 

the torsional rigidity. The most common goal for frame design is a torsionally stiff 

and light frame. Design changes could include different beam lengths, cross 

sections, or material properties.

It is important to note that the torsional rigidity was evaluated and set up with 

respect to the experiment that would be performed once the frame is made. We 

can only compare experiment to analysis if the boundary conditions are set up in 

the same manner. Additionally, assumptions are made in the finite element model 

that might not reflect the real world situation perfectly. Therefore, it is most 

advantageous to evaluate different frame designs using the software to decide 

which is the stiffest, not one that matches the experiment perfectly.
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Lesson 7
Intake Analysis

When you complete this lesson, you will be able to:

� Set up and run a Flow Simulation;

� Post-process a flow simulation.
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Intake Manifold Design

The common goal of intake manifold 

design is even distribution of flow to the 

piston heads. This is to insure optimum 

engine efficiency. In this lesson, 

SolidWorks Flow Simulation will be used 

to investigate the design of our intake 

manifold when the car is moving at 22 

m/s (50 mph).

This lesson will introduce the complete set up of a SolidWorks Flow Simulation 

project. We will prepare our model for analysis, set up boundary conditions and 

engineering goals, run our project, and learn to post process our results.

Model Preparations

In structural analysis, it is typically necessary to simplify the SolidWorks 

geometry to allow the simulation to run. The same is true for flow analysis. A 

simplified model will result in faster mesh and run times providing you with a 

quicker result. Part of model preparation is deciding what type of model you will 

be running. SolidWorks Flow Simulation categorizes flow analysis in terms of the 

flow being either internal or external.

External Flow Analysis

This type of analysis involves the study of flow around a region not necessarily 

bounded by solid geometry. Typically, this is used for the study of flow over 

aircrafts, automobiles, buildings, etc.

Internal Flow Analysis

Internal flow analysis deals with the study of flow inside a region bounded by 

solid geometry. A typical example of an internal flow analysis would be the flow 

through and HVAC system. In this type of analysis, flow enters the model through 

some inlet and leaves the model through the outlet. Flow Simulation requires the 

model to be fully closed to perform an internal analysis, therefore some geometry 

modifications may be necessary prior to setting up the model. This will be the 

case in our analysis of the intake manifold.

1 Open Intake Assembly. 
Click File, Open and select the part Intake Assembly. Click Open to open the 
part.
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2 Start SolidWorks Flow Simulation.

Click Tools, Add-Ins. Select SolidWorks Flow 

Simulation.

Click OK.
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SolidWorks Flow Simulation Interface

SolidWorks Flow Simulation functions are accessed in the same way as 

SolidWorks. When a simulation study is created, a Flow Simulation analysis tree 

appears as a tab next to the FeatureManager design tree tab. Each new study that 

gets created is linked to a specific configuration created in the 

ConfigurationManager. Like SolidWorks functions, Flow Simulation functions 

can be accessed from the Flow Simulation toolbars, CommandManager, or Flow 

Simulation drop-down menu. Additionally, functions can be selected by right-

clicking geometry or items in the Flow Simulation analysis tree.

Lids

As mentioned previously, internal analysis requires the geometry of the model to 

be fully closed. In the intake manifold, there is an opening for the inlet flow and 

four ports for the flow to the cylinders. We must close these openings with lids. 

We will then apply the proper boundary conditions to the surface of these lids to 

tell Flow Simulation how the fluid will be entering or leaving through the lid 

surface.

CommandManager tab

CommandManager

Flow Simulation

Toolbars

Flow Simulation
analysis tree
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3 Create lids.

From the Flow Simulation drop-down menu, select Tools, 

Create Lids.

Select the planar faces on the inlet and the four outlet ports 

that the lid will cover.

Select Adjust Thickness and enter 1mm as the Thickness.

Click .

You’ll notice nine new parts in the FeatureManager design tree. The lids are blind 

extrusions from the selected planar faces into the openings with a distance that 

was specified as the Thickness. The annular lids can be neglected as they would 

not come in contact with the internal fluid.

Note: The thickness of the lid for an internal analysis is usually not important however, 

the lid should not be so thick that the flow pattern is affected down stream. For 

most cases, the lid thickness could be the same thickness used to create the 

neighboring walls.

Tip: If the lid face is not planar, the lid tool cannot be used. In this case, simply create 

the lid manually using a mid plane extrusion.
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Check Geometry

SolidWorks Flow Simulation has a tool called Check Geometry that allows users 

to check the solid geometry to make sure that it is ready for analysis. We know 

that the geometry must be fully closed for an internal analysis.

Additionally, we need to make sure that no 

invalid contacts exist in our model. An invalid 

contact will cause the Check Geometry tool to 

report zero internal volume and the Flow 

Simulation will fail to solve. Some examples of 

invalid contact are shown in the figure.

4 Check geometry.

From the Flow Simulation menu choose: 

Tools, Check Geometry.

Make sure the Exclude Cavities without 

flow conditions check box is cleared.

Click Check.

The tool should calculate a fluid volume 

correctly and there should be no invalid 

contacts.

If invalid contacts exist, you must correct 

them before beginning the flow 

simulation project.

Click Close when you are satisfied.

Creating the Project

Now that our geometry has been properly modified, we can proceed with the Flow 

Simulation project.

5 Create a project.

From the Flow Simulation menu, choose: Project, Wizard.
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6 Create new project.

Under Configuration, click Create new to create a new configuration.

In the Configuration name box, enter Project 1.

Click Next.

Note: SolidWorks Flow Simulation will create and activate a new configuration called 

Project 1 when the wizard is finished. All data associated with running the 
analysis will be stored in a separate folder in the model directory numbered 

sequentially, i.e. “1”, “2”, “3”... etc. based on how many projects are defined on 

this model.
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7 Select units.

Select SI (m-kg-s) as the Unit System for this project.

8 Select analysis type.

Select Internal under Analysis Type.

Click Next.
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9 Select fluid.

Expand the Gases tree and double-click Air to add it to the Project Fluids list.

Click Next.

10 Select wall conditions.

Accept the default conditions and click Next.



SolidWorks Intake Analysis
Engineering Design and Technology Series

Creating the Project 190

11 Initial conditions.

Accept the default conditions and click Next.

12 Results and Geometry Resolution.

Set the Result Resolution to 5.

Click Finish.
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13 Review Flow Simulation analysis tree.

SolidWorks Flow Simulation has created and 

activated an additional configuration called 

Project 1. In addition, the Flow Simulation 

analysis tree tab has been created in the 

FeatureManager.

Select the Flow Simulation analysis tree tab .

If changes need to be made to the settings of the project, you can right click the 

Input Data folder and select the appropriate option.

In the graphics window, the Computational 

Domain is shown as a wireframe box 

enveloping the model. This is the area 

where the model will solve the flow 

simulation. Because this is an internal 

analysis, the model will be solved inside the 

solid geometry inside the box.

14 Insert boundary condition.

In the Flow Simulation analysis tree, under 

Input Data, right-click Boundary 
Conditions and select Insert Boundary 
Condition.

Select the inside surface of the lid covering the 

inlet as shown in the figure.

To access the inner face, right click the outer 

face on the lid and click Select Other. In the 

Select Other window, cycle through the faces 

by moving the pointer to highlight each face 

dynamically in the graphics window.



SolidWorks Intake Analysis
Engineering Design and Technology Series

Creating the Project 192

15 Set up boundary condition.

Under Type select Flow Openings.

Select Inlet Velocity.

Under Flow Parameters, click Normal to Surface and 

enter 22 m/s.

Click .

16 Insert boundary condition.

In the Flow Simulation analysis tree, under 

Input Data, right-click Boundary 
Conditions and select Insert Boundary 
Condition.

Select the inside face of one of the lids 

covering the outlet ports as shown in the 

figure.
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17 Set up boundary condition.

Under Type select Pressure Openings.

Select Environment Pressure.

Click .

18 Set up boundary condition.

Repeat this procedure to create Environment Pressure boundary conditions for the 

remaining three outlet ports.
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Engineering Goals

SolidWorks Flow Simulation contains built in criteria to stop the solution process. 

In addition, it is best to use your own criteria by using engineering goals. 

Engineering goals are user specified parameters of interest which users can 

display while the solver is running and obtain information about after 

convergence is reached. Goals can be set throughout an entire domain (Global), in 

a selected area (Surface, Point), or within a selected volume (Volume). Finally, 

mathematical expressions using other goals can be written in an equation goal.

19 Surface goal.

In the SolidWorks Flow Simulation analysis 

tree, right-click Goals, and select Insert 
Surface Goals.

To select the inlet surface for the Surface 

Goals, split the feature pane and in the upper 

portion click the boundary condition Inlet 
Velocity 1 item in the Flow Simulation 

analysis tree to input the face where the 

surface goal is to be applied.

In the Parameter list, locate Volume Flow 

Rate and check the box.

Click .

20 Rename goal.

Rename the goal so that it appears as Inlet Volume Flow Rate.
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21 Surface goal.

Repeat the previous steps to apply a surface 

goal for the volume flow rate at the outlets.

When selecting the Environment 
Pressure boundary conditions, hold the 
control key and select all of the outlet 

conditions.

Click Create a separate goal for each 

surface. This will create a separate goal for 

each outlet.

Click .

Rename each goal to reflect the outlets.

22 Equation goal.

Right-click Goals and select Insert Equation Goal.

Select the Outlet Volume Flow Rate 1 surface goal that was defined in the 
previous step to add it to the Expression box.

Click + in the Equation Goal window.

Repeat this procedure to sum all of the outlet goals.

Click OK.
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23 Rename goal.

Rename the goal so that it appears as Sum of Outlet Volume Flow Rates.

24 Solve.

In the Flow Simulation analysis tree, right-click the project and select Run.

Make sure that Load Results is selected.

Click Run with the default settings.

It could take up to an hour to run this study.

Post-Processing

We can begin to post-process the results once the solver is completed. In this part 

of the lesson, we will learn about various post processing options available in 

SolidWorks Flow Simulation. We first must change the transparency of the model 

so that we can view the results.

25 Change transparency.

In the Flow Simulation menu, select Results, Display, Transparency.

Move the slider to 0.75.

Note: The transparency can also be changed by right-click the parts in the 

FeatureManager design tree.

26 Cut plot.

In the Flow Simulation analysis tree, right-click Cut Plots and select Insert.

Select the Top plane of the plenum assembly.

Click .
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Color Bar

In the Color Bar dialog box, you can specify a physical parameter for the display. 

You also have control over various settings of the display. You can access the 

Color Bar double-clicking on the legend in the plot.

27 Adjust view settings.

Double-click the legend to bring up the Color Bar 

dialog.

Change the Parameter to Velocity.

Change the Number of colors to 110.

Click OK.

Hide the Cut Plot when you are through.
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28 Flow trajectory.

In the Flow Simulation analysis tree, right-click Flow Trajectories and select 
Insert.

Select the Inlet Velocity 1 boundary condition.

Enter 50 as the Number of Points. Click .

Hide the Flow Trajectories when you are through.

29 Surface plot.

In the Flow Simulation analysis tree, right-click Surface Plots and select 
Insert.

Select Use all faces.

Make sure Contours is selected and the Parameter is Pressure. Click .
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30 Goals plot.

In the Flow Simulation analysis tree, right click Goal Plots and select Insert.

Click All in the Goal Plots window and click OK.

An Excel spreadsheet will be automatically created containing information about 

the goals.

Discussion

As we can see from the goals plot, the inlet volume flow rate matches the outlet 

volume flow rate. This is a good sanity check in that all the flow entering the 

model is leaving the model. In addition, we notice the different volume flow rates 

exiting each outlet condition. Much of the flow is leaving through one of the 

outlets in the center. This was also seen with the flow trajectory plot. This could 

be because the outlet port is slightly off-set from the center of the plenum, causing 

more flow to leave through one side. Re-design of the plenum could better 

distribute the flow amongst the outlet ports.

In the real world, each piston would be firing at a different time as the engine is 

running. To more accurately represent this situation, a transient study could be set 

up with the outlet ports turning on and off with respect to when they would fire 

using time curves. To set this up in SolidWorks Flow Simulation, Time 

Dependent would need to be selected in the Analysis Type window of the 

Wizard. In addition, modifications to the outlet boundary conditions would be 

needed to specify when they turn on (flow is allowed) and off (flow is restricted).

Conclusions

In this lesson, we investigate the design of the intake manifold using SolidWorks 

Flow Simulation. We learned how to setup and run a flow analysis. We also 

learned good post-processing techniques for evaluating our designs. You are 

encouraged to continue you investigations of the post-processing options 

available on your own. In addition, more information in the form of tutorials and 

technical writings are available through the help menus.


